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features of your new laser product
Your new machine is equipped with a number of special features that improve the quality of the documents you print.
With the machine, you can:

Print with excellent quality and speed
• You can print with a resolution of up to 1200*600 dpi.
• Your machine prints A4-sized paper at up to 16 ppm,(ML-

1640 series), 22 ppm (ML-2240 series) and lettersized 
paper at up to 17ppm (ML-1640 series), 23ppm(ML-2240 
series). 

Handle many different types of printable material
• The 150-sheet tray supports plain paper in various sizes, 

letterhead, envelopes, labels, custom-sized media, 
postcards, and heavy paper.

Create professional documents
• Print watermarks. You can customize your documents with 

words, such as “Confidential”. See Software section.
• Print posters. The text and pictures of each page of your 

document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster. See 
Software section.

• You can use preprinted forms and letterhead with plain 
paper. See Software section.

Save time and money
• To save paper, you can print multiple pages on one single 

sheet of paper.
• This machine automatically conserves electricity by 

substantially reducing power consumption when not in use.
.

Print in various environments
• You can print with various operating system such as 

Windows, Linux and Macintosh systems.
• Your machine is equipped with a USB interface.

SPECIAL FEATURES
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FEATURES BY MODELS
The machine is designed to support all of your document needs.
Basic features of this machine include;

( : Included) 

ABOUT THIS USER’S GUIDE
This user’s guide provides information about basic understanding of the machine as well as detailed explanation on each step during the actual usage. Both novice 
users and professional users can refer to this guide for installing and using the machine.
Some terms in this guide are used interchangeably, as below:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• The explanation in this user guide is mainly based on ML-2240 Series. Some illustrations might be different for ML-1640 Series. 
Following table offers the conventions of this guide:

FEATURES ML-1640 ML-2240
USB 2.0 Full speed

Duplex (2-sided) printing (Manual)

CONVENTION DESCRIPTION EXAMPLE

Bold Used for texts on the display or actual prints on the machine. Start

Note Used to provide additional information or detailed specification of the machine 
function and feature.

The date format may differ from 
country to country

Caution Used to give users information to protect the machine from possible mechanical 
damage or malfunction.

Do not touch the green underside of 
the toner cartridge.

Footnote Used to provide more detailed information on certain words or a phrase. a. pages per minute

(See page 1 for more 
information)

Used to guide users to the reference page for the additional detailed information. (See page 1 for more information)
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FINDING MORE INFORMATION
You can find information for setting up and using your machine from the following resources, either as a print-out or onscreen.

Please visit www.samsung.com for open source information.

Quick Install Guide Provides information on setting up your machine and this requires that you follow the instructions in the guide to prepare the machine.

Online User’s Guide Provides you with step-by-step instructions for using your machine’s full features, and contains information for maintaining your 
machine, troubleshooting, and installing accessories. 
This user’s guide also contains a Software section to provide you with information on how to print documents with your machine in 
various operating systems, and how to use the included software utilities.

You can access the user’s guide in other languages from the Manual folder on the printer software CD.

Printer Driver Help Provides you with help information on printer driver properties and instructions for setting up the properties for printing. To access a 
printer driver help screen, click Help from the printer properties dialog box.

Samsung website If you have Internet access, you can get help, support, printer drivers, manuals, and order information from the Samsung website, 
www.samsungprinter.com.

http://www.samsungprinter.com
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safety information
IMPORTANT SAFETY SYMBOLS AND PRECAUTIONS

What the icons and signs in this user’s guide mean:

These warning signs are here to prevent injury to you and others. Follow them explicitly. After reading this section, keep it in a safe 
place for future reference.

WARNING

Hazards or unsafe practices that may result in severe personal injury or death.

CAUTION

Hazards or unsafe practices that may result in minor personal injury or property damage.

CAUTION

To reduce the risk of fire, explosion, electric shock, or personal injury when using your laser MFP, follow these basic safety 
precautions:

Do NOT attempt.

Do NOT disassemble.

Do NOT touch.

Follow directions explicitly.

Unplug the power plug from the wall socket.

Make sure the MFP is grounded to prevent electric shock.

Call the service center for help.

1. Read and understand all instructions.
2. Use common sense whenever operating electrical appliances.
3. Follow all warnings and instructions marked on the machine and in the literature accompanying the machine.

4. If an operating instruction appears to conflict with safety information, heed the safety information. You may have misunderstood the 
operating instruction. If you cannot resolve the conflict, contact your sales or service representative for assistance.

5. Unplug the machine from the AC wall socket before cleaning. Do not use liquid or aerosol cleaners. Use only a damp cloth for 
cleaning.

6. Do not place the machine on an unstable cart, stand or table. It may fall, causing serious damage.
7. Your machine should never be placed on, near or over a radiator, heater, air conditioner or ventilation duct. 
8. Do not allow anything to rest on the power cable. Do not locate your machine where the cords will be abused by persons walking on 

them.

9. Do not overload wall outlets and extension cords. This can diminish performance, and may result in the risk of fire or electric shock.
10. Do not allow pets to chew on the AC power or PC interface cords. 
11. Never push objects of any kind into the machine through case or cabinet openings. They may touch dangerous voltage points, 

creating a risk of fire or shock. Never spill liquid of any kind onto or into the machine.

12. To reduce the risk of electric shock, do not disassemble the machine. Take it to a qualified service technician when repair work is 
required. Opening or removing covers may expose you to dangerous voltages or other risks. Incorrect reassembly could cause 
electric shock when the unit is subsequently used. 
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LASER SAFETY STATEMENT
The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and 
elsewhere is certified as a Class I laser product conforming to the requirements of IEC 825.
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.

WARNING 
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

13. Unplug the machine from the PC and AC wall outlet, and refer servicing to qualified service personnel under the following conditions:
• When any part of the power cord, plug, or connecting cable is damaged or frayed.
• If liquid has been spilled into the machine. 
• If the machine has been exposed to rain or water.
• If the machine does not operate properly after instructions have been followed.
• If the machine has been dropped, or the cabinet appears damaged.
• If the machine exhibits a sudden and distinct change in performance.

14. Adjust only those controls covered by the operating instructions. Improper adjustment of other controls may result in damage, and 
may require extensive work by a qualified service technician to restore the machine to normal operation.

15. Avoid using this machine during a lightning storm. There may be a remote risk of electric shock from lightning. If possible, unplug the 
AC power for the duration of the lightning storm.

16. If you continuously print multiple pages, the surface of the output tray may become hot. Be careful not to touch the surface, and keep 
children away from the surface.

17. The Power cord supplied with your machine should be used for safe operation. If you are using a cord which is longer than 2 m with 
110 V machine, then it should be 16 AWGa or bigger.

18. SAVE THESE INSTRUCTIONS
19. This machine can be operated only in the country you have purchased. (Due to different voltage, frequency, telecommunication 

configuration and etc)

a.AWG: American Wire Gauge
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OZONE SAFETY
During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is 
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, request your nearest Samsung dealer.

RECYCLING
Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

CORRECT DISPOSAL OF THIS PRODUCT (WASTE ELECTRICAL & ELECTRONIC EQUIPMENT)

(Applicable in the European Union and other European countries with separate collection systems)
This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB 
cable)  should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or 
human health  from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to pro-
mote the sustainable  reuse of material resources.
Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and 
how  they can take these items for environmentally safe recycling.  
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic  
accessories should not be mixed with other commercial wastes for disposal.

RADIO FREQUENCY EMISSIONS

FCC Information to the User
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 

• This device may not cause harmful interference, and 
• This device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la 
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to oper-
ate the equipment.
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REPLACING THE FITTED PLUG (FOR UK ONLY)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until 
you have another fuse cover. 
Contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have 
normal 13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

Important warning: 
You must earth this machine.
The wires in the mains lead have the following color code:
• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live
If the wires in the mains lead do not match the colors marked in your plug, do the following:
You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or 
green.
You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

DECLARATION OF CONFORMITY (EUROPEAN COUNTRIES)

Approvals and Certifications
The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable 93/
68/EEC Directives of the European Union as of the dates indicated:
The declaration of conformity may be consulted at www.samsung.com/printer, go to Support > Download center and enter your printer 
name to browse the EuDoC.
January 1, 1995: Council Directive 73/23/EEC Approximation of the laws of the member states related to low voltage equipment.
January 1, 1996: Council Directive 89/336/EEC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic 
compatibility.
March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of 
their conformity.
A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics Co., Ltd. 
representative.

If you cut off the moulded plug, get rid of it straight away.
You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

http://www.samsung.com/printer
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introduction
These are the main components of your machine:

This chapter includes:
• Printer overview
• Control panel overview
• Understanding the control panel

• Supplied software
• Printer driver features

 

PRINTER OVERVIEW
Front view

Rear view

The illustrations of the machine are based on ML-2240 series. ML-1640 series does not have a manual tray.

1 Top cover

2 Output tray (face down)

3 Output support

4 Control panel

5 Front cover handle

6 Front cover

7 Paper input tray

8 Toner cartridge

9 Manual traya

‘

10 Rear guides

11 Paper covera

12 Side guides

a.ML-2240 only.

1 USB port

2 Power switch

3 Power receptacle
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CONTROL PANEL OVERVIEW

1 On-Line/Error LED Shows the status of your machine. (See "Understanding the control panel" on page 13 for more information.)

2 Toner LED Shows the status of the toner cartridge. (See "Understanding the control panel" on page 13 for more information.)

3
Cancel Stops an operation at any time and there are more functions. (See "Understanding the control panel" on page 13 for more 

information.)
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UNDERSTANDING THE CONTROL PANEL
The color of the On-Line/Error LED and toner LED indicates the machine's 
current status.

On-Line/Error LED

Toner LED

Cancel button

STATUS DESCRIPTION

Green On The machine is warming up or ready to receive the 
data.

Blinking The machine is printing data. 

Red On • The machine is experiencing an error, such as 
open cover, paper empty, installer error,
 or invalid error. 

• The machine is experiencing a service required 
error, such as LSU error, or fuser error. Contact 
your sales or service representative. 

Orange On The machine is experiencing an error such as 
jammed paper.

STATUS DESCRIPTION

Red On A toner cartridge has reached its estimated 
cartridge life. The printer stops printing. Replace 
the toner cartridge. (See "Replacing the toner 
cartridge" on page 28.) 

Blinking Small amount of toner is left in the cartridge. The 
estimated cartridge life of toner is close. Prepare 
a new cartridge for replacement. You may 
temporarily increase the printing quality by 
redistributing the toner. (See "Redistributing 
toner" on page 27)  

Rapidly 
blinking

A toner cartridge has almost reached its 
estimated cartridge life. Replace the toner 
cartridge. (See "Replacing the toner 
cartridge" on page 28.)

All printing errors will be appear in the Smart Panel program window.

Estimated cartridge life means the expected or estimated toner 
cartridge life, which indicates the average capacity of print-outs and is 
designed pursuant to ISO/IEC 19752. (See "Specifications" on 
page 40.) The number of pages may be affected by operating 
environment, printing interval, media type, and media size. Some 
amount of toner may remain in the cartridge even when the red LED 
turned on and the printer stops printing.
Samsung does not recommend using non-genuine Samsung toner 
cartridge such as refilled or remanufactured. Samsung cannot 
guarantee non-genuine Samsung toner cartridge's quality. Service or 
repair required as a result of using non-genuine Samsung toner 
cartridges will not be covered under the machine warranty.

STATUS DESCRIPTION

Printing demo page In ready mode, press and hold this 
button until the On-Line/Error LED 
blinks, and release.

Canceling print job Press this button during printing. The 
red LED blinks while the print job is 
cleared from both the machine and 
the computer, and then the machine 
returns to ready mode. This may take 
some time depending on the size of 
the print job.

Manual print Press this button during printing. The 
On Line/Error LED blinks while the 
print job is cleared from both the 
machine and the computer, and then 
return to ready mode. This may take 
some time depending on the size of 
the print job.
In Manual Feed mode, you can’t 
cancel the print job by pressing this 
button. 
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SUPPLIED SOFTWARE
After you have set up your machine and connected it to your computer, you 
must install the printer software. If you are a Windows or Macintosh OS, 
install the software from the supplied CD and if you are a Linux OS user, 
download the software from the Samsung website (www.samsung.com/
printer) and install.

PRINTER DRIVER FEATURES
Your printer drivers support the following standard features:
• Paper orientation, size, source and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers:

Printer driver
 

OS CONTENTS

Windows • Printer driver: Use this driver to take full advantage of your 
printer’s features.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

Linux • Printer driver: Use this driver to run your machine from 
a Linux computer and print documents.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

Macintosh • Printer driver: Use this driver to run your machine from 
a Macintosh computer and print documents.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

FEATURE WINDOWS LINUX MACINTOSH

Machine quality option O O O

Poster printing O X X

Multiple pages per sheet 
(N-up)

O O (2,4) O 

Fit to page printing O X Oa

a.This feature is supported only in MAC OS X 10.4~10.6

Scale printing O X O

Watermark O X X

Overlay O X X

Toner Save O X O

Duplex (Manual) O X X

http://www.samsung.com/printer
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getting started
This chapter gives you step-by-step instructions for setting up the machine.

This chapter includes:
• Setting up the hardware
• Printing a demo page

• System requirements
• Installing the software

SETTING UP THE HARDWARE
This section shows the steps to set up the hardware which is explained in 
the Quick Install Guide. Make sure you read Quick Install Guide and 
complete the following steps.
1. Select a stable location. 

Select a level, stable place with adequate space for air circulation. Allow 
extra space to open covers and trays. 
The area should be well-ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to the 
edge of your desk or table.

 

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to the 
altitude setting to optimize your printing. Place the machine on a flat and 
stable surface, not letting it lean more than 2 mm (0.08 inches). 
Otherwise, it may affect the printing quality. 

2. Unpack the machine and check all the enclosed items.
3. Remove the tape holding the machine tightly.
4. Install all four of the toner cartridge.
5. Load paper. (See "Loading paper" on page 21.)
6. Make sure that all the cables are connected to the machine. 

7. Turn the machine on. 

PRINTING A DEMO PAGE
Print a demo page to make sure that the machine is operating correctly.
To print a demo page:
In ready mode, press and hold the Cancel button for about 2 seconds.

When you move the machine, do not tilt or turn it upside down. 
Otherwise, the inside of the machine may be contaminated by toner, 
which can cause damage to the machine or bad print quality.
This equipment will be inoperable when mains power fails.



16 _Getting started

SYSTEM REQUIREMENTS
Before you begin, ensure that your system meets the following 
requirements:

Windows
Your machine supports the following Windows operating systems.

Macintosh

Linux

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Windows 
2000

Pentium II 400 MHz 
(Pentium III 933 MHz)

64 MB 
(256 MB)

300 MB

Windows XP Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB 
(256 MB)

1GB

Windows 
Server 2003

Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB 
(512 MB)

1.25 GB to 
2 GB

Windows 
Server 2008

Pentium IV 1 GHz
(Pentium IV 2 GHz)

512 MB 
(2048 MB)

10 GB

Windows 
Vista

Pentium IV 3 GHz 512 MB 
(1024 MB)

15 GB

Windows 7 Pentium IV 1 GHz 32-bit 
or 64-bit processor or 
higher

1 GB 
(2 GB)

16 GB

• Support for DirectX 9 graphics with 128 MB 
memory(to enable the Aero theme).

• DVD-R/W Drive

Windows 
Server 2008 
R2

Pentium IV 1 GHz(x86) or 
1.4GHz(x64) 
processors(2GHz or 
faster)

512 MB 
(2048 MB)

10 GB

• Internet Explorer 5.0 or higher is the minimum requirement for all 
Windows operating systems.

• Users who have an administrator right can install the software.

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM
FREE 
HDD 

SPACE

Mac OS X 10.4 
or lower

• Power PC 
G4/G5

• Intel 
processors

• 128 MB for a Power 
PC based Mac 
(512 MB)

• 512 MB for an Intel 
based Mac (1 GB)

1 GB

Mac OS X 10.5 • 867MHz or 
faster Power 
PC G4 /G5

• Intel 
processors

512 MB (1 GB) 1 GB

Mac OS X 10.6 • Intel 
processors

1 GB (2 GB) 1 GB

ITEM REQUIREMENTS

Operating system • RedHat 8.0, 9.0 (32bit)
• RedHat Enterprise Linux WS 4, 5 (32/64bit)
• Fedora Core 1~7 (32/64bit)
• Mandrake 9.2 (32bit), 10.0, 10.1 (32/64bit)
• Mandriva 2005, 2006, 2007 (32/64bit)
• SuSE Linux 8.2, 9.0, 9.1 (32bit)
• SuSE Linux 9.2, 9.3, 10.0, 10.1 10.2 (32/64bit)
• SuSe Linux Enterprise Desktop 9, 10 (32/64bit)
• Ubuntu 6.06, 6.10, 7.04 (32/64bit)
• Debian 3.1, 4.0 (32/64bit)

CPU Pentium IV 2.4 GHz (IntelCore2)

RAM 512 MB (1024MB)

Free HDD space 1 GB (2GB)
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INSTALLING THE SOFTWARE
You have to install the machine software for printing. The software includes 
drivers, applications, and other user friendly programs. 

1. Make sure that your machine is connected to the computer. 
2. Insert the Printer Software CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation window 
appears. 
If the installation window does not appear, click Start > Run. Type 
X:\Setup.exe, replacing “X” with the letter which represents your drive 
and click OK.
If you use Windows Vista, Windows 7 and Windows 2008 Server R2 
click Start > All Programs > Accessories > Run, and type 
X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, Windows 7 and 
Windows 2008 Server R2 click Run Setup.exe in Install or run 
program field, and click Continue in the User Account Control 
window.

3. Click Next.    

• The window above may slightly differ, if you are reinstalling the 
driver.

• View User’s Guide: Allows you to view the User’s Guide. If your 
computer does not have Adobe Acrobat, clicking on this button will 
automatically install Adobe Acrobat Reader for you, and then open 
the User’s Guide.

4. Select Typical, and then click Next.
 

5. After the installation is finished, a window appears asking you to print a 
test page and to register yourself as a user of Samsung machines in 
order to receive information from Samsung. If  you desire, select the 
corresponding checkbox(es) and click Finish.

The following procedure is based on the Windows XP operating 
system. The procedure and popup window which appear during the 
installation may differ depending on the operating system, the printer 
feature, or the interface in use.

• If your machine does not work properly after the installation, try 
to reinstall the printer driver. See Software section.

• During the printer driver installation process, the driver installer 
detects the location information for your operating system and 
sets the default paper size for your machine. If you use a 
different Windows location, you must change the paper size to 
match the paper you usually use. Go to printer properties to 
change the paper size after installation is complete.
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selecting and loading print media
This chapter introduces you how to load originals and print media into your machine.

This chapter includes:
• Selecting print media
• Loading paper

• Printing on special print medias
• Setting the paper size and type

SELECTING PRINT MEDIA
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meets the 
guidelines for use with your machine. Print media that does not meet the 
guidelines outlined in this user’s guide may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.
Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described later in this section.
• Desired outcome: The print media you choose should be appropriate for 

your project.
• Brightness: Some print media are whiter than others and produce 

sharper, more vibrant images.
• Surface smoothness: The smoothness of the print media affects how 

crisp the printing looks on the paper.

The illustrations of the machine are based on ML-2240 series. ML-1640 series does not have a manual tray.

• Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of 
improper handling, unacceptable temperature and humidity levels, 
or other variables over which Samsung has no control.

• Before purchasing large quantities of print media, ensure that it 
meets the requirements specified in this user’s guide. 

Using print media that does not meet these specifications may cause 
problems, requiring repairs. Such repairs are not covered by 
Samsung’s warranty or service agreements.
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Specifications on print media

TYPE SIZE DIMENSIONS WEIGHTA CAPACITYB

Plain paper Letter 216 x 279 mm (8.5 x 11 inches) • 60 to 90 g/m2 (16 to 24 lb bond) for 
the tray

• 60~165 g/m2 (16 to 40 lb bond) for 
manual feeding in the try

• 150 sheets of 75 g/m2 (20 lb 
bond) paper for the tray

• 1 sheet for manual feeding in 
the tray

Legal 216 x 356 mm (8.5 x 14 inches)

Folio 216 x 330 mm (8.5 x 13 inches)

A4 210 x 297 mm (8.26 x 11.69 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

JIS B5 182 x 257 mm (7.16 x 10.11 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.82 x 8.26 inches)

A6 105 x 148 mm (4.13 x 5.82 inches)

Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches) 75 to 90 g/m2 (20 to 24 lb bond)

1 sheet for manual feeding in 
the tray

No. 10 105 x 241 mm (4.12 x 9.5 inches)

DL 110 x 220 mm (4.33 x 8.66 inches)

C5 162 x 229 mm (6.37 x 9.01 inches)

C6 114 x 162 mm (4.48 x 6.38 inches)

Thick paper Refer to the Plain 
paper section

Refer to the Plain paper section 90 to 105 g/m2 (24 to 28 lb bond)

Labelsc Letter, A4 Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lb bond)

Transparency Letter, A4 Refer to the Plain paper section 138 to 146 g/m2 (37 to 39 lb bond)

Card stock Post card 101.6 x 152.4 mm (4 x 6 inches) 90 to 163 g/m2 (24 to 40 lb bond)

Minimum size (custom) 76 x 127 mm (3 x 5 inches) 60 to 165 g/m2 (16 to 40 lb bond) 

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)

a. If media weight is over 90 g/m2 (24 lb bond), load a paper into the tray one by one.
b.Maximum capacity may differ depending on media weight, thickness, and environmental conditions.
c. Smoothness: 100 to 250 (sheffield)
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Guidelines for special print media

MEDIA TYPE GUIDELINES

Envelopes • Successful printing on envelopes depends upon the 
quality of the envelopes. When selecting envelopes, 
consider the following factors:
- Weight: The weight of the envelope paper should 

not exceed 90 g/m2 or jamming may occur.
- Construction: Prior to printing, envelopes should 

lie flat with less than 6 mm curl, and should not 
contain air.

- Condition: Envelopes should not be wrinkled, 
nicked, or otherwise damaged.

- Temperature: You should use envelopes that are 
compatible with the heat and pressure of the 
machine during operation.

• Use only well-constructed envelopes with sharp and 
well creased folds.

• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, 

coated lining, self-adhesive seals, or other synthetic 
materials.

• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope 

extends all the way to the corner of the envelope.

1 Acceptable
2 Unacceptable

• Envelopes with a peel-off adhesive strip or with 
more than one flap that folds over to seal must use 
adhesives compatible with the machine’s fusing 
temperature for 0.1 second. Check your machine’s 
specification to view the fusing temperature, see 
page 40. The extra flaps and strips might cause 
wrinkling, creasing, or jams, and may even damage 
the fuser.

• For the best print quality, position margins no closer 
than 15 mm from the edges of the envelope.

• Avoid printing over the area where the envelope’s 
seams meet.

Labels • To avoid damaging the machine, use only labels 
designed for use in laser machines.
- When selecting labels, consider the following 

factors:
- Adhesives: The adhesive material should be 

stable at your machine’s fusing temperature. 
Check your machine’s specification to view the 
fusing temperature, see page 40.

- Arrangement: Only use labels with no exposed 
backing between them. Labels can peel off sheets 
that have spaces between the labels, causing 
serious jams.

- Curl: Prior to printing, labels must lie flat with no 
more than 13 mm of curl in any direction.

- Condition: Do not use labels with wrinkles, 
bubbles, or other indications of separation.

• Make sure that there is no exposed adhesive 
material between labels. Exposed areas can cause 
labels to peel off during printing, which can cause 
paper jams. Exposed adhesive can also cause 
damage to machine components.

• Do not run a sheet of labels through the machine 
more than once. The adhesive backing is designed 
for only a single pass through the machine.

• Do not use labels that are separating from the 
backing sheet or are wrinkled, bubbled, or otherwise 
damaged.

Card stock or 
custom-sized 
materials

• Do not print on media smaller than 76 mm wide or 
127 mm long.

• In the software application, set margins at least 
6.4 mm away from the edges of the material.

Transparencies • To avoid damaging the machine, use only 
transparencies designed for use in laser printers.

• Transparencies used in the machine must be able 
to withstand 180 °C, the machine’s fusing 
temperature.

• Place them on a flat surface after removing them 
from the machine.

• Do not leave them in the paper tray for long periods 
of time. Dust and dirt may accumulate on them, 
resulting in spotty printing.

• To avoid smudging caused by fingerprints, handle 
them carefully.

• To avoid fading, do not expose printed 
transparencies to prolonged sunlight.

• Ensure that transparencies are not wrinkled, curled, 
or have any torn edges.

• Do not use transparencies that separates from the 
backing sheet.

• To prevent trancsparencies from sticking to each 
other, do not leave the printed sheets stack up as 
they are printed out. 

MEDIA TYPE GUIDELINES
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LOADING PAPER
Loading paper in the tray
Load the print media you use for the majority of your print jobs in the tray. 
The tray can hold a maximum of 150 sheets of 75 g/m2 (20 lb bond) plain 
paper. 
1. Grasp the paper input tray and pull it toward you to open. Pinch the rear 

guide and pull it out to extend the tray.

2. Prepare a stack of paper for loading by flexing or fanning them back and 
forth. Straighten the edges on a level surface. 

3. Load paper with the print side facing up. Make sure that all four corners 
are flat in the tray. 

Preprinted paper • Letterhead must be printed with heat-resistant ink 
that will not melt, vaporize, or release hazardous 
emissions when subjected to the machine’s fusing 
temperature for 0.1 second. Check your machine’s 
specification to view the fusing temperature, see 
page 40.

• Letterhead ink must be non-flammable and should 
not adversely affect printer rollers.

• Forms and letterhead should be sealed in a 
moisture-proof wrapping to prevent changes during 
storage.

• Before you load preprinted paper, such as forms 
and letterhead, verify that the ink on the paper is 
dry. During the fusing process, wet ink can come off 
preprinted paper, reducing print quality.

Using photographic paper or coated paper may cause problems, 
requiring repairs. Such repairs are not covered by Samsung’s 
warranty or service agreements.

MEDIA TYPE GUIDELINES

Because the machine is very light, it may be moved when you use it; 
for example, when opening/closing the tray or installing/removing the 
toner cartridge. Be careful not to move the machine. 

Pay attention not to overload paper. Paper overloading may 
cause paper jams.
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4. Pinch the rear guide to adjust for the paper length and pinch the side 
guide and slide it to the left flush against the paper. 

5. If necessary, close the paper cover to keep the paper loaded in the tray 
from dust. 

PRINTING ON SPECIAL PRINT MEDIAS
The machine can hold special sizes and types of print material, such as 
postcards, note cards, and envelopes. Especially, it is useful for single page 
printing on letterhead or colored paper.

Feeding the print material manually
• Load only one size of print media at a time in the tray.
• To prevent paper jams, do not add paper when there is still paper in 

the tray. This also applies to other types of print media.
• Print media should be loaded face up with the side you want to print, 

and the top edge going into the tray first. Place print materials in the 
center of the tray.

• Always load only the specified print media to avoid paper jams and 
print quality problems. (See "Selecting print media" on page 18.)

• Flatten any curl on postcards, envelopes, and labels before loading 
them into the tray.

1. Grasp the paper input tray and pull it toward you to open. Pinch the rear 
guide and pull it out to extend the tray.

2. Place the dust cover on the paper input tray. 
(For ML-1640 Series, skip this step and go to the next step.) 

• Do not push the width guide far enough to cause the material to 
warp.

• If you do not adjust the width guide, it may cause paper jam. 

Because the machine is very light, it may be moved when you use it; 
for example, when opening/closing the tray or installing/removing the 
toner cartridge. Be careful not to move the machine. 
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3. Load the paper in the manual tray.
      (For ML-1640 Series, load paper in the paper input tray.

 

4. When you print in application, start the print menu.
5. Open printer properties.
6. Press the Paper tab in printer properties, and select an appropriate 

paper type. 

7. Select Manual Feeder in paper source then, press OK. 
8. Start printing in application.

9. Press and hold the Cancel button until machine starts operating. 

SETTING THE PAPER SIZE AND TYPE
After loading paper in the paper tray, you need to set the paper size and 
type using the printer driver. Follow these steps to make your changes 
permanent. 

1. Click the Start button on the computer screen.
2. Select Printers and Faxes.
3. Right-click on the printer driver icon and select Printing Preferences.
4. Click the Paper tab, and change the settings on Paper Options.
5. Click OK.

Envelope Preprinted paper Transparency

Label Card stock Letterhead paper

For printing on labels or cardstocks using the manual tray, feed one 
paper at a time. We recommend you to first fill the paper input tray 
with papers for smooth printing. 

If you want to use a label, set the paper type to Label. 

• If you are printing multiple pages, load the next sheet after first 
page prints out, and press the Cancel button. Repeat this 
step for every page to be printed.

• The settings you change remain in effect only while you are 
using the current application. 

The following procedure is for Windows XP. For other Windows OS, 
refer to the corresponding Windows User's Guide or online help. 

If you want to use special sized paper such as a billing paper, select 
Custom in the Paper tab in the printer properties.  See Software 
section.
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basic printing
This chapter explains common printing tasks.

This chapter includes:
• Printing a document • Canceling a print job

PRINTING A DOCUMENT
Your machine allows you to print from various Windows, Macintosh, or 
Linux applications. The exact steps for printing a document may vary 
depending on the application you use.
For details about printing, see the Software section.

CANCELING A PRINT JOB
If the print job is waiting in a print queue or print spooler, such as the printer 
group in Windows, delete the job as follows:
1. Click the Windows Start menu.
2. For Windows 2000, select Settings and then Printers.

For Windows XP/2003, select Printers and Faxes.
For Windows Vista/2008, select Control Panel > Hardware and Sound 
> Printers.
For Windows 7, select Control Panel → Hardware and Sound → 
Devices and Printers.
For Windows Server 2008 R2, select Control Panel → Hardware → 
Devices and Printers.

3. For Windows 2000, XP, 2003, 2008 and Vista, double-click your 
machine.
For Windows 7 and Windows Server 2008 R2, right click your printer 
icon→ context menus → See what’ s printing.

4. From the Document menu, select Cancel.

You can also cancel the current job by pressing Cancel on the control 
panel.

You can also access this window by simply double-clicking the printer 
icon at the bottom right corner of the Windows desktop.
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maintenance
This chapter provides information for maintaining your machine and the toner cartridge.

This chapter includes:
• Cleaning your machine
• Maintaining the cartridge

• Replacing the toner cartridge

CLEANING YOUR MACHINE
To maintain print quality, follow the cleaning procedures below each time 
the toner cartridge is replaced or if print quality problems occur.

Cleaning the outside
Clean the cabinet of the machine with a soft lint-free cloth. You can dampen 
the cloth slightly with water, but be careful not to let any water drip onto or 
into the machine.

Cleaning the inside
During the printing process, paper, toner, and dust particles can accumulate 
inside the machine. This buildup can cause print quality problems, such as 
toner specks or smearing. Cleaning the inside of the machine clears or 
reduces these problems.
1. Turn the machine off and unplug the power cord, then wait for the 

machine to cool down.
2. Open the front cover.

3. Pull the toner cartridge out and remove it from the machine.

4. Remove the manual tray by pulling it out.

The illustrations of the machine are based on ML-2240 series. ML-1640 series does not have a manual tray.

• Cleaning the cabinet of the machine with cleaning materials 
containing large amounts of alcohol, solvent, or other strong 
substances can discolor or distort the cabinet.

• If your machine or its surrounding is contaminated with toner, we 
recommend you to use cloth or tissue dampened with water to 
clean it. If you use a vacuum cleaner, toner blown into the air may 
be harmful. 

For ML-2240 Series, if you have installed the dust cover, remove the 
dust cover before opening the front cover. 

Because the machine is very light, it may be moved when you use it; 
for example, when opening/closing the tray or installing/removing the 
toner cartridge. Be careful not to move the machine. 

ML-1640 series does not have a manual tray, go to step 5.
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5. With a dry, lint-free cloth, wipe away any dust and spilled toner from the 
toner cartidge area and the toner cartridge cavity. 

 

6. Locate the long strip of glass (LSU) inside the top of the cartridge 
compartment, and gently swab the glass to see if dirt turns the white 
cotton black.

   

7. After inserting the manual tray and the toner cartridge, close the cover. 
Make sure that the cover is securely closed. If it is not firmly closed, 
printing errors may occur when you print.

8. Plug in the power cord, and turn the machine on.

To prevent damage to the toner cartridge, do not expose it
to light for more than few minute. Cover it with a piece of paper, if
necessary. Also, do not touch the black transfer roller inside the
machine.

 If it is not firmly closed, printing errors may occur when you print.
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MAINTAINING THE CARTRIDGE
Toner cartridge storage
Toner cartridges contain components that are sensitive to light, 
temperature, and humidity. Samsung suggests users follow the 
recommendations to ensure the optimum performance, highest quality, and 
longest life from your new Samsung toner cartridge.

Store this cartridge in the same environment as the printer it will be used in; 
this should be in controlled office temperature and humidity conditions. The 
toner cartridge should remain in its original, unopened package until 
installation – If original packaging is not available, cover the top opening of 
the cartridge with paper and store in a dark cabinet. 
Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, always store the cartridge:

• Inside the protective bag from the original package 
• Correct side up in a horizontal position (not standing on end)
• Do not store consumables in; 

- Temperature greater than 40°C (104°F). 
- Humidity range less than 20% and not greater than 80%.
- An environment with extreme changes in humidity or temperature.
- Direct sunlight or room light.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

Handling instructions
• Do not touch the surface of the photosensitive drum in the cartridge. 
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge
Samsung Electronics does not recommend or approve the use of non-
Samsung brand toner cartridges in your printer including generic, store 
brand, refilled, or remanufactured toner cartridges. 

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print-out number may 
vary depending on the print density of the pages you print on, operating 
environment, printing interval, media type, and/or media size. For example, 
if you print a lot of graphics, the consumption of the toner is high and you 
may need to change the cartridge more often.

Redistributing toner
Small amount of toner is left in the cartridge. You can temporarily improve 
print quality by redistributing the toner.
1. Open the front cover.

2. Pull the toner cartridge out and remove it from the machine.

• Samsung’s printer warranty does not cover damage to the 
machine caused by the use of a refilled, remanufactured, or non-
Samsung brand toner cartridge.

For ML-2240 Series, if you have installed the dust cover, remove the 
dust cover before opening the front cover. 

• Avoid reaching too far into the machine. The fusing area may be 
hot.

• To prevent damage to the toner cartridge, do not expose it to light 
for more than few minutes.

• Do not touch the green surface (or sky blue), the OPC drum, with 
your hands or any other material. Use the handle on the cartidge 
to avoid touching this area.

• Be careful not to expose the green surface (or sky blue), the OPC 
drum, into light. This will cause damage to the OPC drum. Cover 
the toner cartridge’s OPC drum with paper to avoid damaging it 
from the light.

• Do not turn the toner cartridge over.

Because the machine is very light, it may be moved when you use it; 
for example, when opening/closing the tray or installing/removing the 
toner cartridge. Be careful not to move the machine. 
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3. Gently shake the toner cartridge from side to side five or six times to 
redistribute the toner. 

4. Reinsert the toner cartridge into the machine. Ensure that the toner 
cartridge snaps into place.

5. Close the front cover. Make sure that the cover is securely closed. If it is 
not firmly closed, printing errors may occur when you print.

REPLACING THE TONER CARTRIDGE
When the toner LED lights red, a toner cartridge has reached its estimated 
cartridge life. Your machine stops printing.
Also, the Smart Panel program window appears on the computer telling you 
to replace the cartridge.
At this stage, the toner cartridge needs to be replaced. Check the type of 
toner cartridge for your machine. (See "Supply" on page 39.)
1. Turn the machine off, then wait a few minutes for the machine to cool.
2. Grasp the front cover and pull it toward you to open.

3. Remove the toner cartridge from its bag and remove the paper 
protecting the cartridge by pulling the packing tape.

If toner gets on your clothing, wipe it off with a dry
cloth and wash it in cold water. Hot water sets toner into
fabric.

For ML-2240 Series, if you have installed the dust cover, remove the 
dust cover before opening the front cover. 

Because the machine is very light, it may be moved when you
use it; for example, when opening/closing the tray or installing/
removing the toner cartridge. Be careful not to move the machine.

• Do not touch the green surface (or sky blue), the OPC drum, 
with your hands or any other material. Use the handle on the 
cartidge to avoid touching this area.

• Be careful not to expose the green surface (or sky blue), the 
OPC drum, into light. This will cause damage to the OPC 
drum. Cover the toner cartridge’s OPC drum with paper to 
avoid damaging it from the light. 

• Do not turn the toner cartridge over. 
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4. Holding both handles on the toner cartridge, thoroughly rock it from side 
to side to evenly distribute the toner.

5. Locate the cartridge slots inside the machine, one on each side.
 

6. Unfold the toner cartridge handle and grasp it. Insert the cartridge in the 
machine until it snaps into place.

7. Close the front cover. Make sure that the cover is securely closed. If the 
cover is not firmly closed, printing errors may occur when you print.

If toner gets on your clothing, wipe it off with a dry cloth and wash 
it in cold water. Hot water sets toner into fabric.

• Don't use sharp objects, such as a knife or scissors, to open 
the toner cartridge package. You could damage the surface of 
the toner cartridge.

• To prevent damage, do not expose the toner cartridge to light 
for more than a few minutes. Cover it with a piece of paper to 
protect it if necessary. Carefully insert or pull out the toner cartridge not to scratch

against the machine.

• Do not touch the green surface (or sky blue), the OPC drum, 
with your hands or any other material. Use the handle on the 
cartidge to avoid touching this area.

• Be careful not to expose the green surface (or sky blue), the 
OPC drum, into light. This will cause damage to the OPC 
drum. Cover the toner cartridge’s OPC drum with paper to 
avoid damaging it from the light. 

• Do not turn the toner cartridge over. 

Average yield for a new toner cartridge is 1,500 standard pages in 
accordance with the ISO/IEC 19752 standard. (Average yield for the 
original toner cartridge supplied with the machine is 700 standard 
pages.) 
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troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

This chapter includes:
• Tips for avoiding paper jams
• Clearing paper jams

• Solving other problems

TIPS FOR AVOIDING PAPER JAMS
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, follow the steps outlined on page 30. 
• Follow the procedures on page 21. Ensure that the adjustable guides 

are positioned correctly.
• Do not overload the tray. Ensure that the paper level is below the paper 

capacity mark on the inside of the tray.
• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media. (See "Setting the paper size and 

type" on page 23.)
• Ensure that the recommended side of the print media is facing up in the 

tray.

If a paper jam occurs, the error LED on the control panel lights orange. Find 
and remove the jammed paper. 
To resume printing after clearing paper jams, you must open and close the 
front cover.

CLEARING PAPER JAMS
In the paper exit area

1. If the paper jams as it exits to the output tray and a long portion of the 
paper is visible, pull the paper straight out. 

When you pull the jammed paper, if there is resistance and the paper 
does not move immediately, stop pulling. Continue with the next step.

The illustrations of the machine are based on ML-2240 series. ML-1640 series does not have a manual tray.

Paper jams in this area may result in loose toner on the
page. If you get any toner on your clothes, wash them in cold
water as hot water will set the toner into the fabric.
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2. Open the top cover and the inner cover.

3. Loosen the paper if it is caught in the heat rollers. Then pull the paper 
gently out. 

 

4. Close the inner cover and the top cover. Printing resumes automatically. 

In the paper feed area
1. Remove any misfeed paper by pulling it out by the visible edge from the 

tray. Make sure that all of the paper is properly aligned in the tray.

2. Open and close the front or top cover to resume printing the 
document from failed pages.

• When removing the jammed paper, be careful not to touch the 
heat roller (located underneath the inner cover). It is hot and 
could cause burns!

• The top and inner cover themselves may also be hot due to 
the heat roller. Allow the machine to cool before opening the 
covers.

Failed pages will not reprint. Try printing the pages.
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Around the toner cartridge
1. Open the front cover.

2. Pull the toner cartridge out and remove it from the machine.

3. Gently pull the paper toward you.

4. Check that there is no other paper in the machine.
5. Reinstall the toner cartridge and close the front cover. Your machine 

resumes printing the document from failed pages.

SOLVING OTHER PROBLEMS
The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, call for service.

Paper feeding 

For ML-2240 Series, if you have installed the dust cover, remove the 
dust cover before opening the front cover. 

• Do not touch the green surface (or sky blue), the OPC drum, 
with your hands or any other material. Use the handle on the 
cartidge to avoid touching this area.

• Be careful not to expose the green surface (or sky blue), the 
OPC drum, into light.This will cause damage to the OPC 
drum.Cover the toner cartridge’s OPC drum with paper to 
avoid damaging it from the light. 

• Do not turn the toner cartridge over. 

CONDITION SUGGESTED SOLUTIONS

Paper is jammed 
during printing.

Clear the paper jam. See page 30.

Paper sticks 
together.

• Ensure there is not too much paper in the tray. 
The tray can hold up to 150 sheets of paper, 
depending on the thickness of your paper.

• Make sure that you are using the correct type 
of paper. See page 23.

• Remove paper from the tray and flex or fan the 
paper.

• Humid conditions may cause some paper to 
stick together.

Multiple sheets of 
paper do not feed.

• Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

• If multiple sheets have caused a paper jam, 
clear the paper jam. See page 30.

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine. See page 18.
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Printing problems

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, load only one size of print 
media at a time in the tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine. See page 19.

• There may be debris inside the machine. Open 
the front cover and remove the debris.

Envelopes skew or 
fail to feed correctly.

Ensure the paper guides are against both sides of 
the envelopes.

CONDITION SUGGESTED SOLUTIONS

CONDITION POSSIBLE 
CAUSE SUGGESTED SOLUTIONS

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord 
connections. Check the 
power switch and the power 
source.

The machine is not 
selected as the 
default printer.

Select Samsung ML-2240 
Series as your default printer 
in your Windows.

• Check the machine for the following:
• The front cover is not closed. Close the cover.
• Paper is jammed. Clear the paper jam. See page 

30.
• No paper is loaded. Load paper. See page 21.
• The toner cartridge is not installed. Install the 

toner cartridge.
• If a system error occurs, contact your service 

representative.

The connection 
cable between the 
computer and the 
machine is not 
connected properly.

Disconnect the printer cable 
and reconnect it.

The connection 
cable between the 
computer and the 
machine is 
defective.

If possible, attach the cable 
to another computer that is 
working properly and print a 
job. You can also try using a 
different printer cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has 
more than one port, make 
sure that the machine is 
attached to the correct one.

The machine may 
be configured 
incorrectly. 

Check the printer properties 
to ensure that all of the print 
settings are correct. 

The printer driver 
may be incorrectly 
installed.

Repair the printer software. 
See the Software section.

The machine is 
malfunctioning.

Check the LEDs status on 
the control panel to see if the 
machine is indicating a 
system error.

The machine 
does not print 
special sized 
paper such as a 
billing paper. 

Paper size and 
paper size setting do 
not match.

Set the correct paper size in 
the Custom in the Paper tab 
in the printer properties.  See 
Software section
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The machine 
selects print 
materials from 
the wrong paper 
source.

The paper source 
selection in the 
printer properties 
may be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Paper tab within 
the printer properties. Select 
the correct paper source. 
See the printer driver help 
screen.

A print job is 
extremely slow.

The job may be very 
complex.

Reduce the complexity of the 
page or try adjusting the print 
quality settings.

Half the page is 
blank.

The page orientation 
setting may be 
incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the 
tray.
Or, ensure that the paper 
size in the printer driver 
settings matches the paper 
selection in the software 
application settings you use.

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The printer cable is 
loose or defective.

Disconnect the printer cable 
and reconnect. Try a print job 
that you have already printed 
successfully. If possible, 
attach the cable and the 
machine to another computer 
and try a print job that you 
know works. Finally, try a 
new printer cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine 
off and then back on again.

Pages print, but 
are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary. See page 27.
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such as 
the controller or the 
board, may be 
defective.

Contact a service 
representative.

CONDITION POSSIBLE 
CAUSE SUGGESTED SOLUTIONS

The machine 
does not print 
PDF file 
correctly. Some 
parts of 
graphics, text, or 
illustrations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products.

Printing the PDF file as an 
image may solve this 
problem. Turn on Print As 
Image from the Acrobat 
printing options.

It will take longer to 
print when you print a 
PDF file as an image.

Your machine 
has an odd smell 
during initial 
use.

The oil used to 
protect the fuser is 
evaporating.

 It is a temporary issue.

The print quality 
of photos is not 
good. Images 
are not clear.

The resolution of the 
photo is very low. 

Reduce the photo size. If you 
increase the photo size in the 
software application, the 
resolution will be reduced. 

Before printing, 
the machine 
emits vapor near 
the output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

CONDITION POSSIBLE 
CAUSE SUGGESTED SOLUTIONS
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
you may notice a reduction in print quality. See the table below to clear the 
problem.

CONDITION SUGGESTED SOLUTIONS

Light or faded print If a vertical white streak or faded area appears on 
the page:
• The toner supply is low. You may be able to 

temporarily extend the toner cartridge life. See 
page 27. If this does not improve the print 
quality, install a new toner cartridge.

• The paper may not meet paper specifications; 
for example, the paper is too moist or too 
rough. See page 18.

• If the entire page is light, the print resolution 
setting is too low. Adjust the print resolution. 
See the help screen of the printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning.

• The surface of the LSU part inside the machine 
may be dirty. Clean the LSU by opening and 
closing the front cover several times and if the 
problem still occurs call the contact a service 
representative.

Toner specks • The paper may not meet specifications; for 
example, the paper is too moist or too rough. 
See page 18.

• The paper path may need cleaning. See 
"Cleaning the inside" on page 25.

Dropouts If faded areas, generally rounded, occur randomly 
on the page:
• A single sheet of paper may be defective. Try 

reprinting the job.
• The moisture content of the paper is uneven or 

the paper has moist spots on its surface. Try a 
different brand of paper. See page 18.

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go to 
printer properties, click Paper tab, and set type 
to Thick. Refer to the Software section for 
details.

If these steps do not correct the problem, contact a 
service representative.

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

White Spots White spots appear on the page:
• The paper is too rough and a lot of dirt from the 

paper falls to the inner devices within the 
machine, which means the transfer belt may be 
dirty. Clean the inside of your machine. Contact 
a service representative.

• The paper path may need cleaning. Contact a 
service representative.

Vertical lines If white vertical streaks appear on the page:
• The surface of the LSU part inside the machine 

may be dirty. Clean the LSU by opening and 
closing the front cover several times and if the 
problem still occurs contact a service 
representative.

Black background If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper. See page 18.
• Check the machine’s environment: very dry 

(low humidity) or high humidity (higher than 
80% RH) conditions can increase the amount 
of background shading.

• Remove the old toner cartridge and install a 
new one. See page 28.

Toner smear • Clean the inside of the machine. See page 25.
• Check the paper type and quality. See page 18.
• Remove the toner cartridge and install a new 

one. See page 28.

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The toner cartridge may be damaged. If a 

repetitive mark occurs on the page, print a 
cleaning sheet several times to clean the 
cartridge. After the printout, if you still have the 
same problems, remove the toner cartridge and 
install a new one. See page 28.

• Parts of the machine may have toner on them. 
If the defects occur on the back of the page, the 
problem will likely correct itself after a few more 
pages.

• The fusing assembly may be damaged. 
Contact a service representative.

CONDITION SUGGESTED SOLUTIONS
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Background scatter Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing with a 

different batch of paper. Do not open packages 
of paper until necessary so that the paper does 
not absorb too much moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing over 
areas that have overlapping seams on the 
reverse side. Printing on seams can cause 
problems.

• If background scatter covers the entire surface 
area of a printed page, adjust the print 
resolution through your software application or 
the printer properties.

Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock may 
be too slick. Try a different paper. See page 18.

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. See page 18.
• Ensure that the paper or other material is loaded 

correctly and the guides are not too tight or too 
loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper curl. 
See page 18.

• Turn over the stack of paper in the tray. Also try 
rotating the paper 180° in the tray.

Wrinkles or creases • Ensure that the paper is loaded properly.
• Check the paper type and quality. See page 18.
• Turn over the stack of paper in the tray. Also try 

rotating the paper 180° in the tray.

CONDITION SUGGESTED SOLUTIONS

A

AaBbCcAaBbCcAaBbCcAaBbCcAaBbCc

Back of printouts 
are dirty

• Check for leaking toner. Clean the inside of the 
machine. See page 25.

 Black pages • The toner cartridge may not be installed 
properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective and need 
replacing. Remove the toner cartridge and install 
a new one. See page 28.

• The machine may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the machine. See page 25.
• Check the paper type and quality. See page 18.
• Remove the toner cartridge and install a new 

one. See page 28.
• If the problem persists, the machine may require 

repair. Contact a service representative.

Character Voids Character voids are white areas within parts of 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some character 
voids are normal. 

• You may be printing on the wrong surface of 
the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper specifications. 
See page 18.

Horizontal stripes If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and reinsert 
it.

• The toner cartridge may be defective. Remove 
the toner cartridge and install a new one. See 
page 28.

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

CONDITION SUGGESTED SOLUTIONS

A

A
AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc
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Common Windows problems

Common Linux problems

Curl If the printed paper is curled or paper does not feed 
into the machine:
• Turn over the stack of paper in the tray. Also try 

rotating the paper 180° in the tray. 
• Change the printer option and try again. Go to 

printer properties, click Paper tab, and set type 
to Thin. Refer to the Software section for 
details.

An unknown image 
repetitively appears 
on a next few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your machine is probably being used at an altitude 
of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality such 
as loose toner or light imaging. You can set this 
option through Paper or Printer tab in printer 
driver’s properties.

CONDITION SUGGESTED SOLUTIONS

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the StartUp Group, then restart 
Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred.” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in ready mode 
or after printing has been completed, check the 
connection and/or whether an error has 
occurred.

Refer to the Microsoft Windows documentation that came with your 
computer for further information on Windows error messages.

CONDITION SUGGESTED SOLUTIONS

CONDITION SUGGESTED SOLUTIONS

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator 
and switch to the Printers tab in Printers 
configuration window to look at the list of 
available printers. Make sure that your 
machine is displayed on the list. If not, 
please, invoke Add new printer wizard to set 
up your device. 

• Check if the printer is started. Open Printers 
configuration and select your machine on the 
printers list. Look at the description in the 
Selected printer pane. If its status contains 
“(stopped)” string, please, press the Start 
button. After that normal operation of the 
printer should be restored. The "stopped" 
status might be activated when some 
problems in printing occurred. 

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

The machine does 
not print whole pages 
and its output is half 
page printed.

The problem is solved in AFPL Ghostscript v. 
8.52 or above. Download the latest version of 
AFPL Ghostscript from http://sourceforge.net/
projects/ghostscript/ and install it to solve this 
problem.

I encounter error 
“Unable to open mfp 
port device file!” 
when printing a 
document.

Please avoid changing print job parameters (via 
LPR GUI, for example) while a print job is in 
progress. Known versions of CUPS server 
break the print job whenever print options are 
changed and then try to restart the job from the 
beginning. Since Unified Linux Driver locks mfp 
port while printing, the abrupt termination of the 
driver keeps the port locked and therefore 
unavailable for subsequent print jobs. If this 
situation occurred, please, try to release the 
mfp port.

Refer to Linux User’s Guide that came with your computer for further 
information on Linux error messages.
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Common Macintosh problems

CONDITION SUGGESTED SOLUTIONS

The machine does not 
print PDF file correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and 
the Acrobat products:
Printing the PDF file as an image may 
solve this problem. Turn on Print As 
Image from the Acrobat printing options.

It will take longer to print when 
you print a PDF file as an image.

The document has 
printed, but the print job 
has not disappeared 
from the spooler in Mac 
OS 10.3.2.

Update your Mac OS to OS 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the Cover page 
printing.

This problem is caused because Mac OS 
cannot create the font during the Cover 
page printing. English alphabet and 
numbers are displayed normally at the 
Cover page.

Refer to Mac OS User’s Guide that came with your computer for 
further information on Mac OS error messages.
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ordering supplies and accessories
This chapter provides information on purchasing cartridges and accessories available for your machine.

This chapter includes:
• Supply • Maintenance parts

SUPPLY
When the toner runs out, you can order the following type of toner cartridge 
for your machine:

MAINTENANCE PARTS
To avoid print quality and paper feed problems resulting from worn parts, 
and to maintain your machine in top working condition the following 
condition, the following items will need to be replaced after the specified 
number of pages, or when the life span of each item has expired. 

 

We highly recommend that this maintenance be performed by an authorized 
service provider, dealer or the retailer where you bought the machine. The 
warranty does not cover the replacement of the maintenance parts after 
their lifespan.

HOW TO PURCHASE
To order Samsung-authorized supplies or accessories, contact your local 
Samsung dealer or the retailer where you purchased your machine, or  visit 
www.samsung.com/supplies and select your country/region to obtain 
information on calling for technical support.

The optional parts or features may differ by countries. Contact your sales representatives whether the part you want is available in your country.

TYPE AVERAGE YIELD PART NUMBER

Standard yielda 
toner unit

a.Declared yield value in accordance with ISO/IEC 19752.

Average cartridge 
yield: 1,500 standard 

pages 

MLT-D108S (Black)
Region Ab

MLT-D1082S (Black)

b.Region A:Albania, Austria, Belgium, Bosnia, Bulgaria, Croatia, Cyprus, 
Czech Republic, Denmark, Finland, France, Germany, Greece, 
Hungary, Italy, Macedonia, Netherlands, Norway, Poland, Portugal, 
Romania, Serbia, Slovakia, Slovenia, Spain, Sweden, Switzerland, UK. 

When you purchase a new toner cartridge or supplies, you must 
purchase them in the same country you have purchased your 
machine.
Otherwise, the toner cartridge or supplies will be incompatible with 
your machine since the configuration of the toner cartridge or 
supplies vary depending on the countries.

ITEMS YIELD (AVERAGE)

Pick-up roller Approx. 50,000 pages

Fuser unit Approx. 50,000 pages

Transfer roller Approx. 50,000 pages

http://www.samsung.com/supplies
http://www.samsung.com/supplies
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specifications
This chapter guides you about this machine’s specifications such as various features.

This chapter include:
• ML-1640 Series specifications • ML-2240 Series Specifications

ML-1640 SERIES SPECIFICATIONS

ITEM DESCRIPTION

Printing 
method

Laser beam printing

Printing speeda  Up to 16 ppm (A4), 17 ppm (Letter)

First print out 
time

• From ready: Less than 10 seconds
• From coldboot: Less than 30 seconds

Print 
resolution

Max. 1,200 x 600 dpi effective output

Printer 
language

SPL

OS 
compatibilityb

• Windows: 2000/XP/2003/Vista/2008/7/Server 2008 
R2

• Linux: RedHat 8.0~9.0, Mandrake 9.2~10.1, SuSE 
8.2~9.2, Fedra Core 1~4, Ubuntu 6.0

• Macintosh: Mac OS 10.3~10.6

Interface Full speed USB 2.0

Paper input 
capacity

Tray: 150 sheets for plain paper, 75 g/m2 (20 lb bond)
For details about paper input capacity, see 19 page.

Paper output 
capacity

Face down: 50 sheets 75 g/m2 (20 lb bond)

Power rating AC 110 - 127 V or AC 220 - 240 V
See the Rating label on the machine for the correct 
voltage, frequency (hertz) and type of current for your 
machine.

Power 
consumption

• Average operating mode: Less than 300 W
• Ready mode: Less than 70 W
• Sleep mode:  Less than 6W
• Power off mode: 0W

Noise Levelc • Ready mode: Less than 26 dBA
• Printing mode: Less than 50 dBA

Warm-up time Less than 35 seconds

Operating 
environment

Temperature: 10 to 32.5 °C (50 to 90 °F)
Humidity: 20 to 80% RH

Toner 
cartridge lifed

Average cartridge yield: 1,500 standard pages
(Shipped with 700 pages toner cartridge./
Chinese ships with 1,500 pages toner cartridge.)e

External 
dimension
(W x D x H)

350.5 x 298.5 x 212 mm 
(13.8 x 11.75 x 8.35 inches)

Weight
(Including 
consumables)

5.66 Kg (12.47 lb)

Package 
weight

Paper: 1 Kg (2.2 lbs)
Plastic: 0.19 Kg (0.42 lbs)

Fusing 
temperature

180 °C (356 °F)

a. It will be affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

b.Visit www.samsungprinter.com to download the latest software 
version.

c. Sound Pressure Level, ISO 7779
d.Declared yield value in accordance with ISO/IEC 19752. The number 

of pages may be affected by operating environment, printing interval, 
media type, and media size.

e. It varies depending on the product configuration.

ITEM DESCRIPTION
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ML-2240 SERIES SPECIFICATIONS

ITEM DESCRIPTION

Printing 
method

Laser beam printing

Printing speeda  Up to 22 ppm (A4), 23 ppm (Letter)

First print out 
time

• From ready: Less than 8.5 seconds
• From coldboot: Less than 18 seconds

Print 
resolution

Max. 1,200 x 600 dpi effective output

Printer 
language

SPL

OS 
compatibilityb

• Windows: 2000/XP/2003/Vista/2008/7/Server 2008 
R2

• Linux: RedHat 8.0~9.0, Mandrake 9.2~10.1, SuSE 
8.2~9.2, Fedra Core 1~4, Ubuntu 6.0

• Macintosh: Mac OS 10.3~10.6

Interface Full speed USB 2.0

Paper input 
capacity

Tray: 150 sheets for plain paper, 75 g/m2 (20 lb bond)
For details about paper input capacity, see 19 page.

Paper output 
capacity

Face down: 100 sheets 75 g/m2 (20 lb bond)

Power rating AC 110 - 127 V or AC 220 - 240 V
See the Rating label on the machine for the correct 
voltage, frequency (hertz) and type of current for your 
machine.

Power 
consumption

• Average operating mode: Less than 350 W
• Ready mode: Less than 70W
• Sleep mode:  Less than 6W
• Power off mode: 0W

Noise Levelc • Ready mode: Less than 33 dBA
• Printing mode: Less than 51 dBA

Warm-up time Less than 25 seconds 

Operating 
environment

Temperature: 10 to 32.5 °C (50 to 90 °F)
Humidity: 20 to 80% RH

Toner 
cartridge lifed

Average cartridge yield: 1,500 standard pages
(Shipped with 700 pages toner cartridge./
Chinese ships with 1,500 pages toner cartridge.)e

External 
dimension
(W x D x H)

350.5 x 298.5 x 212 mm 
(13.8 x 11.75 x 8.35 inches)

Weight
(Including 
consumables)

5.91 Kg (13.03 lb)

Package 
weight

Paper: 1 Kg (2.2 lbs)
Plastic: 0.19 Kg (0.42 lbs)

Fusing 
temperature

180 °C (356 °F)

a. It will be affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

b.Visit www.samsungprinter.com to download the latest software 
version.

c. Sound Pressure Level, ISO 7779
d.Declared yield value in accordance with ISO/IEC 19752. The number 

of pages may be affected by operating environment, printing interval, 
media type, and media size.

e. It varies depending on the product configuration.

ITEM DESCRIPTION
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glossary

ADF
An Automatic Document Feeder (ADF) is a mechanism that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 
client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD 
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage 
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a pseudo standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a mechanism that will 
automatically feed and flip over an original sheet of paper so that the 
machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.

DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically flip over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex can print double-sided of paper.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user's guide.
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An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that melts the toner onto the print media. It 
consists of a hot roller and a back-up roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 

Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over TCP/
IP.
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LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.  

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 00-00-0c-
34-11-4e). This address is usually hard-coded into a Network Interface 
Card (NIC) by its manufacturer, and used as an aid for routers trying to 
locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a codebook-
based run-length encoding scheme optimized to efficiently compress 
white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.

NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or gray colored and a cylinder shaped. 
An exposing unit of a drum is slowly worn away by its usage of the 
printer, and it should be replaced appropriately since it gets scratches 
from grits of a paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, matrix printer, and page 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used on a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated Inter-
process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, text-
based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.
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Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle within a machine like printer which contains toner. Toner 
is a powder used in laser printers and photocopiers, which forms the text 
and images on the printed paper. Toner can be melted by the heat of the 
fuser, causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a TWAIN-
compliant scanner with a TWAIN-compliant program, a scan can be 
initiated from within the program.; an image capture API for Microsoft 
Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.
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contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

ARGENTINE 0800-333-3733 www.samsung.com/ar

AUSTRALIA 1300 362 603 www.samsung.com/au

AUSTRIA 0810-SAMSUNG (7267864, 
€ 0.07/min)

www.samsung.com/at

BELARUS 810-800-500-55-500 www.samsung/ua
www.samsung.com/ua_ru

BELGIUM 02 201 2418 www.samsung.com/be 
(Dutch)
www.samsung.com/be_fr 
(French)

BRAZIL 0800-124-421
4004-0000

www.samsung.com/br

CANADA 1-800-SAMSUNG 
(726-7864)

www.samsung.com/ca

CHILE 800-SAMSUNG (726-7864) www.samsung.com/cl

CHINA 400-810-5858
010-6475 1880

www.samsung.com/cn

COLOMBIA 01-8000112112 www.samsung.com.co

COSTA RICA 0-800-507-7267 www.samsung.com/latin

CZECH 
REPUBLIC

800-SAMSUNG 
(800-726786)

www.samsung.com/cz

Samsung Zrt., česká organizační složka, Oasis Florenc, 
Sokolovská394/17, 180 00, Praha 8

DENMARK 8-SAMSUNG (7267864) www.samsung.com/dk

ECUADOR 1-800-10-7267 www.samsung.com/latin

EL SALVADOR 800-6225 www.samsung.com/latin

ESTONIA 800-7267 www.samsung.com/ee

KAZAKHSTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

KYRGYZSTAN 00-800-500-55-500

FINLAND 30-6227 515 www.samsung.com/fi

FRANCE 01 4863 0000 www.samsung.com/fr

GERMANY 01805 - SAMSUNG 
(726-7864 € 0,14/min)

www.samsung.de

GUATEMALA 1-800-299-0013 www.samsung.com/latin

HONDURAS 800-7919267 www.samsung.com/latin

HONG KONG 3698-4698 www.samsung.com/hk
www.samsung.com/hk_en/

HUNGARY 06-80-SAMSUNG 
(726-7864)

www.samsung.com/hu

INDIA 3030 8282
1800 110011
1800 3000 8282 

www.samsung.com/in

INDONESIA 0800-112-8888 www.samsung.com/id

ITALIA 800-SAMSUNG (726-7864) www.samsung.com/it

JAMAICA 1-800-234-7267 www.samsung.com/latin

JAPAN 0120-327-527 www.samsung.com/jp

LATVIA 8000-7267 www.samsung.com/lv

LITHUANIA 8-800-77777 www.samsung.com/lt

LUXEMBURG 02 261 03 710 www.samsung.com/lu

MALAYSIA 1800-88-9999 www.samsung.com/my

MEXICO 01-800-SAMSUNG 
(726-7864)

www.samsung.com/mx

MOLDOVA 00-800-500-55-500 www.samsung/ua
www.samsung.com/ua_ru

NETHERLANDS 0900-SAMSUNG 
(0900-7267864) (€ 
0,10/min)

www.samsung.com/nl

NEW ZEALAND  0800 SAMSUNG (0800 726 
786)

www.samsung.com/nz

NICARAGUA 00-1800-5077267 www.samsung.com/latin

NORWAY 3-SAMSUNG (7267864) www.samsung.com/no

PANAMA 800-7267 www.samsung.com/latin

PHILIPPINES 1800-10-SAMSUNG 
(726-7864)
1-800-3-SAMSUNG 
(726-7864)
1-800-8-SAMSUNG 
(726-7864)
02-5805777

www.samsung.com/ph

POLAND 0 801 1SAMSUNG 
(172678)
022-607-93-33

www.samsung.com/pl

PORTUGAL 80820-SAMSUNG 
(726-7864)

www.samsung.com/pt

PUERTO RICO 1-800-682-3180 www.samsung.com/latin

REP. DOMINICA 1-800-751-2676 www.samsung.com/latin

EIRE 0818 717 100 www.samsung.com/ie

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

http://www.samsung.com/ar
http://www.samsung.com.co
http://www.samsung.com/at
http://www.samsung.com/be
http://www.samsung.com/br
http://www.samsung.com/ca
http://www.samsung.com/cl
http://www.samsung.com/kz_ru
http://www.samsung.com/au
http://www.samsung.com/latin
http://www.samsung.com/cz
http://www.samsung.com/dk
http://www.samsung.com/latin
http://www.samsung.com/latin
http://www.samsung.com/latin
www.samsung.com/ee
http://www.samsung.com/cn
http://www.samsung.com/fi
http://www.samsung.com/fr
http://www.samsung.de
http://www.samsung.com/latin
http://www.samsung.com/hk
http://www.samsung.com/hu
http://www.samsung.com/in
http://www.samsung.com/id
http://www.samsung.com/it
http://www.samsung.com/latin
http://www.samsung.com/jp
http://www.samsung.com/lv
http://www.samsung.com/lt
http://www.samsung.com/lu
http://www.samsung.com/my
http://www.samsung.com/mx
http://www.samsung.com/nl
http://www.samsung.com/nz
http://www.samsung.com/no
http://www.samsung.com/latin
http://www.samsung.com/ph
http://www.samsung.com/pl
http://www.samsung.com/pt
http://www.samsung.com/latin
http://www.samsung.com/latin
www.samsung.com/ie
http://www.samsung.com
http://www.samsung.com/latin
http://www.samsung.com/latin
http://www.samsung.com/be_fr
http://www.samsung/ua
http://www.samsung.com/be
http://www.samsung.com/ua_ru
http://www.samsung.com/hk_en/
http://www.samsung/ua
http://www.samsung.com/ua_ru
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RUSSIA 8-800-555-55-55 www.samsung.ru

SINGAPORE 1800-SAMSUNG 
(726-7864)

www.samsung.com/sg

SLOVAKIA 0800-SAMSUNG 
(726-7864)

www.samsung.com/sk

SOUTH AFRICA 0860 SAMSUNG 
(726-7864)

www.samsung.com/za

SPAIN 902-1-SAMSUNG(902 172 
678)

www.samsung.com/es

SWEDEN 0771 726 7864 
(SAMSUNG)

www.samsung.com/se

SWITZERLAND 0848-SAMSUNG (7267864, 
CHF 0.08/min)

www.samsung.com/ch

TADJIKISTAN 8-10-800-500-55-500

TAIWAN 0800-329-999 www.samsung.com/tw

THAILAND 1800-29-3232
02-689-3232

www.samsung.com/th

TRINIDAD & 
TOBAGO

1-800-SAMSUNG 
(726-7864)

www.samsung.com/latin

TURKEY 444 77 11 www.samsung.com/tr

U.A.E 800-SAMSUNG (726-7864)
8000-4726

www.samsung.com/ae

U.K 0845 SAMSUNG 
(726-7864)

www.samsung.com/uk

U.S.A 1-800-SAMSUNG 
(7267864)

www.samsung.com/us

UKRAINE 8-800-502-0000 www.samsung/ua
www.samsung.com/ua_ru

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

VENEZUELA 0-800-100-5303 www.samsung.com/latin

VIETNAM 1 800 588 889 www.samsung.com/vn

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

http://www.samsung.ru
http://www.samsung.com/sg
http://www.samsung.com/sk
http://www.samsung.com/za
http://www.samsung.com/es
http://www.samsung.com/se
http://www.samsung.com/ch
http://www.samsung.com/tw
http://www.samsung.com/th
http://www.samsung.com/latin
http://www.samsung.com/tr
http://www.samsung.com/ae
http://www.samsung.com/uk
http://www.samsung.com/us
http://www.samsung/ua
http://www.samsung.com/kz_ru 
http://www.samsung.com/latin
http://www.samsung.com
http://www.samsung.com/vn
http://www.samsung.com/ua_ru


© 2008 Samsung Electronics Co., Ltd. All rights reserved.
This user’s guide is provided for information purposes only. All information included herein is subject to change without notice.
Samsung Electronics is not responsible for any direct or indirect damages, arising from or related to use of this user’s guide.

• Samsung and Samsung logo are trademarks of Samsung Electronics Co., Ltd.
• Microsoft, Windows, Windows Vista, Windows 7 and Windows 2008 Server R2 are either registered trademarks or trademarks of Microsoft Corporation.
• UFST® and MicroType™ are registered trademarks of Monotype Imaging Inc.
• TrueType, LaserWriter and Macintosh are trademarks of Apple Computer, Inc.
• All other brand or product names are trademarks of their respective companies or organizations.
• Refer to the 'LICENSE.txt' file in the provided CD-ROM for the open source license information.



REV 5.00



Samsung Printer

Software section



1

SOFTWARE SECTION 
CONTENTS

Chapter 1: INSTALLING PRINTER SOFTWARE IN WINDOWS

Installing Printer Software ........................................................................................................  4

Reinstalling Printer Software .....................................................................................................  6

Removing Printer Software .......................................................................................................  6

Chapter 2: BASIC PRINTING

Printing a Document ................................................................................................................  7

Printing to a file (PRN)  ............................................................................................................  8

Printer Settings .......................................................................................................................  8
Layout Tab ....................................................................................................................  9

Paper Tab ......................................................................................................................  9

Graphics Tab ...............................................................................................................  10

Extras Tab ...................................................................................................................  11

About Tab ...................................................................................................................  12

Printer Tab ..................................................................................................................  12

Using a Favorite Setting ................................................................................................  12

Using Help ...................................................................................................................  12

Chapter 3: ADVANCED PRINTING

Printing Multiple Pages on One Sheet of Paper (N-Up Printing) .....................................................  13

Printing Posters .....................................................................................................................  14

Printing Booklets  ..................................................................................................................  14

Printing on Both Sides of Paper ...............................................................................................  15

Printing a Reduced or Enlarged Document ................................................................................  15

Fitting Your Document to a Selected Paper Size .........................................................................  15

Using Watermarks .................................................................................................................  16
Using an Existing Watermark .........................................................................................  16

Creating a Watermark ...................................................................................................  16



2

Editing a Watermark .....................................................................................................  16

Deleting a Watermark ...................................................................................................  16

Using Overlays ......................................................................................................................  17
What is an Overlay? ......................................................................................................  17

Creating a New Page Overlay .........................................................................................  17

Using a Page Overlay ....................................................................................................  17

Deleting a Page Overlay ................................................................................................  17

Chapter 4: SHARING THE PRINTER LOCALLY

Setting Up a Host Computer ...................................................................................................  18

Setting Up a Client Computer ..................................................................................................  18

Chapter 5: USING SMART PANEL

Understanding Smart Panel ....................................................................................................  19

Opening the Troubleshooting Guide .........................................................................................  20

Changing the Smart Panel Program Settings .............................................................................  20

Chapter 6: USING YOUR PRINTER IN LINUX

Getting Started .....................................................................................................................  21

Installing the Unified Linux Driver ............................................................................................  21
Installing the Unified Linux Driver ...................................................................................  21

Uninstalling the Unified Linux Driver ...............................................................................  22

Using the Unified Driver Configurator .......................................................................................  23
Opening the Unified Driver Configurator ..........................................................................  23

Printers Configuration ...................................................................................................  23

Ports Configuration .......................................................................................................  24

Configuring Printer Properties .................................................................................................  24

Printing a Document ..............................................................................................................  25
Printing from Applications ..............................................................................................  25

Printing Files ................................................................................................................  25

Chapter 7: USING YOUR PRINTER WITH A MACINTOSH

Installing Software ................................................................................................................  26



3

Setting Up the Printer ............................................................................................................  27

Printing ................................................................................................................................  28
Printing a Document .....................................................................................................  28

Changing Printer Settings ..............................................................................................  28

Printing Multiple Pages on One Sheet of Paper ..................................................................  29



Installing Printer Software in Windows
4

1 Installing Printer 
Software in Windows
This chapter includes:

• Installing Printer Software

• Reinstalling Printer Software

• Removing Printer Software

Installing Printer Software
You can install the printer software for local printing. To install 
the printer software on the computer, perform the appropriate 
installation procedure depending on the printer in use.

A printer driver is software that lets your computer 
communicate with your printer. The procedure to install drivers 
may differ depending on the operating system you are using.

All applications should be closed on your PC before beginning 
installation. 

A local printer is a printer directly attached to your computer 
using the printer cable supplied with your printer, such as a USB 
or parallel cable.

You can install the printer software using the typical or custom 
method.

NOTE: If the “New Hardware Wizard” window appears during 
the installation procedure, click  in the upper right corner of 
the box to close the window, or click Cancel.

This is recommended for most users. All components necessary 
for printer operations will be installed.

1 Make sure that the printer is connected to your computer 
and powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista, Windows 7 and Windows 2008 
Server R2  click Start → All programs → Accessories → 
Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, 
Windows 7 and Windows 2008 Server R2 click Run 
Setup.exe in Install or run program field, and click 
Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.

• View User’s Guide: Allows you to view the User’s 
Guide. If your computer doesn’t have Adobe Acrobat, 
click on this option and it will automatically install Adobe 
Acrobat Reader for you.
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4 Choose the type of installation. Click Next. 

• Typical: Installs the most common software for your 
printer. This is recommended for most users.

• Custom: Allows you to choose the individual 
components you want to install.

NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The installation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

5 After the installation is finished, a window asking you to 
print a test page appears. If you choose to print a test 
page, select the checkbox and click Next.

Otherwise, just click Next and skip to step 7.

6 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

7 To register yourself as a user of Samsung Printers in order 
to receive information from Samsung, select the checkbox 
and click Finish. You are now sent to the Samsung web 
site.

Otherwise, just click Finish.

NOTE: After setup is complete, if your printer driver doesn’t 
work properly, reinstall the printer driver. See “Reinstalling 
Printer Software” on page 6.



Installing Printer Software in Windows
6

Reinstalling Printer Software
You can reinstall the software if installation fails.
1 Start Windows.

2 From the Start menu select Programs or All Programs 
→ your printer driver name → Maintenance.

3 Select Repair and click Next.

You will see a component list so that you can reinstall any 
item individually.

NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The reinstallation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

4 Select the components you want to reinstall and click 
Next.

If you you select your printer driver name and reinstall 
the printer software for local printing, the window asking 
you to print a test page appears. Do as follows:

a. To print a test page, select the check box and click 
Next.

b. If the test page prints out correctly, click Yes.

If it doesn’t, click No to reprint it.
5 When the reinstallation is done, click Finish.

Removing Printer Software

1 Start Windows.

2 From the Start menu select Programs or All Programs 
→ your printer driver name → Maintenance.

3 Select Remove and click Next.

You will see a component list so that you can remove any 
item individually.

4 Select the components you want to remove and then click 
Next.

5 When your computer asks you to confirm your selection, 
click Yes.

The selected driver and all of its components are removed 
from your computer.

6 After the software is removed, click Finish.
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2 Basic Printing 
This chapter explains the printing options and common printing 
tasks in Windows. 

This chapter includes:

• Printing a Document

• Printing to a file (PRN)

• Printer Settings

- Layout Tab

- Paper Tab

- Graphics Tab

- Extras Tab

- About Tab

- Printer Tab

- Using a Favorite Setting

- Using Help

Printing a Document

NOTES: 
• Your printer driver Properties window that appears in this 

User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• Check the Operating System(s) that are compatible 
with your printer. Please refer to the OS Compatibility 
section of Printer Specifications in your Printer User’s 
Guide.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

• When you select an option in printer properties, you may see 

an exclamationmark  or  mark. An exclamation mark 
means you can select that certain option but it is not 

recommended, and  mark means you cannot select that 
option due to the machineís setting or environment.

The following procedure describes the general steps required 
for printing from various Windows applications. The exact steps 
for printing a document may vary depending on the application 
program you are using. Refer to the User’s Guide of your 
software application for the exact printing procedure.

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is 
displayed. It may look slightly different depending on your 
application. 

The basic print settings are selected within the Print 
window. These settings include the number of copies and 
print range.

3 Select your printer driver from the Name drop-down 
list.

To take advantage of the printer features provided by your 
printer driver, click Properties or Preferences in the 
application’s Print window. For details, see “Printer 
Settings” on page 8.

If you see Setup, Printer, or Options in your Print 
window, click it instead. Then click Properties on the next 
screen.

Click OK to close the printer properties window.
4 To start the print job, click OK or Print in the Print 

window.

Make sure that your 
printer is selected.
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Printing to a file (PRN)  
You will sometimes need to save the print data as a file for your 
purpose. 

To create a file:
1 Check the Print to file box at the Print window.

2 Select the folder and assign a name of the file and then 
click OK.

Printer Settings
You can use the printer properties window, which allows you to 
access all of the printer options you need when using your 
printer. When the printer properties are displayed, you can 
review and change the settings needed for your print job. 

Your printer properties window may differ, depending on your 
operating system. This Software User’s Guide shows the 
Properties window for Windows XP.

Your printer driver Properties window that appears in this 
User’s Guide may differ depending on the printer in use.

If you access printer properties through the Printers folder, you 
can view additional Windows-based tabs (refer to your 
Windows User’s Guide) and the Printer tab (see “Printer Tab” on 
page 12).

NOTES:
• Most Windows applications will override settings you specify 

in the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are 
using the current program. To make your changes 
permanent, make them in the Printers folder. 

• The following procedure is for Windows XP. For other 
Windows OS, refer to the corresponding Windows User's 
Guide or online help.
1. Click the Windows Start button.
2. Select Printers and Faxes.
3. Select your printer driver icon.
4. Right-click on the printer driver icon and select 

Printing Preferences.
5. Change the settings on each tab, click OK.
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Layout Tab
The Layout tab provides options to adjust how the document 
appears on the printed page. The Layout Options includes 
Multiple Pages per Side,  Poster Printing and Booklet 
Printing. See “Printing a Document” on page 7 for more 
information on accessing printer properties.  

Paper Orientation
Paper Orientation allows you to select the direction in which 
information is printed on a page. 
• Portrait prints across the width of the page, letter style. 
• Landscape prints across the length of the page, spreadsheet 

style. 
• Rotate allows you to rotate the page the selected degrees.

Layout Options
Layout Options allows you to select advanced printing options. 
You can choose Multiple Pages per Side and Poster Printing.
• For details, see “Printing Multiple Pages on One Sheet of Paper 

(N-Up Printing)” on page 13.
• For details, see “Printing Posters” on page 14
• For details, see “Printing Booklets” on page 14

Double-sided Printing
Double-sided Printing allows you to print on both sides of 
paper. If this option does not appear, your printer does 
not have this feature.
• For details, see “Printing on Both Sides of Paper” on page 15.

 Landscape Portrait

Paper Tab
Use the following options to set the basic paper handling 
specifications when you access the printer properties. See 
“Printing a Document” on page 7 for more information on 
accessing printer properties. 

Click the Paper tab to access various paper properties. 

Copies
Copies allows you to choose the number of copies to be printed. 
You can select 1 to 999 copies. 

Paper Options

Size
Size allows you to set the size of paper you loaded in the tray. 
If the required size is not listed in the Size box, click Custom. 
When the Custom Paper Setting window appears, set the paper 
size and click OK. The setting appears in the list so that you can 
select it. 
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Source
Make sure that Source is set to the corresponding paper tray.
Use Manual Feeder when printing on special materials like 
envelopes and transparencies. You have to load one sheet at a 
time into the Manual Tray or Multi-Purpose Tray.
If the paper source is set to Auto Selection, the printer 
automatically picks up print material in the following tray order: 
Manual Tray or Multi-Purpose Tray, Tray n.

Type
Set Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality 
printout. If not, print quality may not be acheived as you want.
Thick Paper: 24 lb to 28 lb (90~105 g/m2) thick paper.  
Thin Paper: 16 lb to 19 lb (60~70 g/m2) thin paper.  
Cotton: 20 lb to 24 lb (75~90 g/m2) cotton paper such as Gilbert 
25 % and Gilbert 100 %. 
Plain Paper: Normal plain paper. Select this type if your printer is 
monochrome and printing on the 16 lb (60 g/m2) cotton paper. 
Recycled Paper: 20 lb to 24 lb (75~90 g/m2) recycled paper.
Color Paper: 20 lb to 24 lb (75~90 g/m2) color-backgrounded 
paper.  
Archive Paper: If you need to keep print-out for a long period 
time such as archives, select this option.

Scaling Printing
Scaling Printing allows you to automatically or manually scale 
your print job on a page. You can choose from None, Reduce/
Enlarge, and Fit to Page. 
• For details, see “Printing a Reduced or Enlarged Document” on 

page 15.
• For details, see “Fitting Your Document to a Selected Paper 

Size” on page 15.

Graphics Tab
Use the following Graphic options to adjust the print quality for 
your specific printing needs. See “Printing a Document” on 
page 7 for more information on accessing printer properties. 

Click the Graphic tab to display the properties shown below.
   

Resolution
The Resolution options you can select may vary 
depending on your printer model. The higher the setting, 
the sharper the clarity of printed characters and graphics. The 
higher setting also may increase the time it takes to print a 
document. 

Toner Save Mode
Selecting this option extends the life of your toner cartridge and 
reduces your cost per page without a significant reduction in print 
quality. Some printers do not support this feature. 
• Printer Setting: If you select this option, this feature is 

determined by the setting you’ve made on the control panel of 
the printer. 

• On: Select this option to allow the printer to use less toner on 
each page.

• Off: If you don’t need to save toner when printing a document, 
select this option.

Darkness
Use this option to lighten or darken your print job.  Some 
printers do not support this feature. 
• Normal: This setting is for normal documents.
• Light: This setting is for bolder line widths or darker gray-scale 

images.
• Dark: This setting is for finer line width, higher definition in 

graphics, and lighter gray-scale images.
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Advanced Options

You can set advanced settings by clicking the Advanced 
Options button. 
• Print All Text To Black: When the Print All Text To 

Black option is checked, all text in your document prints solid 
black, regardless of the color it appears on the screen. 

• Print All Text To Darken: When the Print All Text To 
Darken option is checked, all text in your document is allowed 
to print darker than on a normal document. Some printers do 
not support this feature. 

Extras Tab
You can select output options for your document. See “Printing 
a Document” on page 7 for more information about accessing 
the printer properties.

Click the Extras tab to access the following feature:  

Watermark
You can create a background text image to be printed on each 
page of your document. For details, see “Using Watermarks” on 
page 16.

Overlay
Overlays are often used to take the place of preprinted forms and 
letterhead paper. For details, see “Using Overlays” on page 17.

Output Options
• Print Subset: You can set the sequence in which the pages 

print. Select the print order from the drop-down list.
- Normal (1,2,3): Your printer prints all pages from the first 
page to the last page.

- Reverse All Pages (3,2,1): Your printer prints all pages 
from the last page to the first page.

- Print Odd Pages: Your printer prints only the odd numbered 
pages of the document.

- Print Even Pages: Your printer prints only the even 
numbered pages of the document.

• Reprint When Jammed: Your printer retains the image of a  
page until the page has been successfully printed out. When the 
paper jam has occured and this option is checked, the printer 
will reprint any incomplete pages after you have cleared the 
jam. Some printers do not support this feature.
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About Tab
Use the About tab to display the copyright notice and the 
version number of the driver. If you have an Internet browser, 
you can connect to the Internet by clicking on the web site icon. 
See “Printing a Document” on page 7 for more information 
about accessing printer properties.

Printer Tab
If you access printer properties through the Printers folder, 
you can view the Printer tab. You can set the printer 
configuration.

The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.
1 Click the Windows Start menu. 

2 Select Printers and Faxes.

3 Select your printer driver icon. 

4 Right-click on the printer driver icon and select 
Properties.

5 Click the Printer tab and set the options.  

Using a Favorite Setting  
The Favorites option, which is visible on each properties tab, 
allows you to save the current properties settings for future 
use. 

To save a Favorites item:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 

When you save Favorites, all current driver settings are 
saved.

To use a saved setting, select the item from the Favorites drop 
down list. The printer is now set to print according to the 
Favorites setting you selected. 

To delete a Favorites item, select it from the list and click 
Delete. 

You can also restore the printer driver’s default settings by 
selecting Printer Default from the list. 

Using Help
Your printer has a help screen that can be activated by clicking 
the Help button in the printer properties window. These help 
screens give detailed information about the printer features 
provided by the printer driver.

You can also click  from the upper right corner of the window, 
and then click on any setting. 
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3 Advanced Printing
This chapter explains printing options and advanced printing 
tasks. 

NOTE: 
• Your printer driver Properties window that appears in this 

User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

This chapter includes:

• Printing Multiple Pages on One Sheet of Paper (N-Up 
Printing)

• Printing Posters

• Printing Booklets

• Printing on Both Sides of Paper

• Printing a Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Using Watermarks

• Using Overlays

Printing Multiple Pages on One 
Sheet of Paper (N-Up Printing) 
You can select the number of pages to print on a single sheet 
of paper. To print more than one page per sheet, the pages will 
be reduced in size and arranged in the order you specify. You 
can print up to 16 pages on one sheet.  

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 7.

2 From the Layout tab, choose Multiple Pages per Side in 
the Layout Type drop-down list. 

3 Select the number of pages you want to print per sheet 
(1, 2, 4, 6, 9, or 16) in the Pages per Side drop-down 
list.

4 Select the page order from the Page Order drop-down 
list, if necessary. 

Check Print Page Border to print a border around each 
page on the sheet. 

5 Click the Paper tab, select the paper source, size, and 
type.

6 Click OK and print the document. 

1 2

3 4
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Printing Posters
This feature allows you to print a single-page document onto 4, 
9, or 16 sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 7.

2 Click the Layout tab, select Poster Printing in the 
Layout Type drop-down list.

3 Configure the poster option:

You can select the page layout from Poster<2x2>, 
Poster<3x3> or Poster<4x4>. If you select 
Poster<2x2>, the output will be automatically stretched 
to cover 4 physical pages. 

Specify an overlap in millimeters or inches to make it 
easier to pasting the sheets together. 

4 Click the Paper tab, select the paper source, size, and 
type.

5 Click OK and print the document. You can complete the 
poster by pasting the sheets together. 

0.15 inches

0.15 inches

Printing Booklets 

This printer feature allows you to print your document on both 
sides of the paper and arranges the pages so that the paper can 
be folded in half after printing to produce a booklet. 
1 To change the print settings from your software 

application, access the printer properties. See “Printing a 
Document” on page 7.

2 From the Layout tab, choose Booklet Printing from the 
Layout Type drop-down list. 

NOTE: The Booklet Printing option is not available for all 
paper sizes. In order to find out the available paper size for 
this feature, select the paper size in the Size option on the 
Paper tab, then check if the Booklet Printing in a Layout 
Type drop-down list on the Layout tab is activated.

3 Click the Paper tab, and select the paper source, size, and 
type.

4 Click OK and print the document.

5 After printing, fold and staple the pages. 

8 9
8 9
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Printing on Both Sides of Paper
You can print on both sides of a sheet of paper. Before printing, 
decide how you want your document oriented.

The options are:

• None

• Long Edge, which is the conventional layout used in 
book binding.

• Short Edge, which is the type often used with calendars.

NOTE: 
• Do not print on both sides of labels, transparencies, 

envelopes, or thick paper. Paper jamming and damage to the 
printer may result. 

1 To change the print settings from your software 
application, access printer properties. “Printing a 
Document” on page 7.

2 From the Layout tab, select the paper orientation.

3 From the Double-sided Printing section, select the 
binding option you want.     

4 Click the Paper tab and select the paper source, size, and 
type.

5 Click OK and print the document.

NOTE: If your printer does not have a duplex unit, you should 
complete the printing job manually. The printer prints every 
other page of the document first. After printing the first side of 
your job, the Printing Tip window appears. Follow the on-
screen instructions to complete the printing job.

 Long Edge▲  Short Edge▲

2 5
3

2

5
3

2 5
3

2

5
3

Printing a Reduced or Enlarged 
Document 
You can change the size of a page’s content to appear larger or 
smaller on the printed page. 

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 7. 

2 From the Paper tab, select Reduce/Enlarge in the 
Printing Type drop-down list. 

3 Enter the scaling rate in the Percentage input box.

You can also click the  or  button.
4 Select the paper source, size, and type in Paper Options. 

5 Click OK and print the document. 

Fitting Your Document to a 
Selected Paper Size
This printer feature allows you to scale your print job to any 
selected paper size regardless of the digital document size. This 
can be useful when you want to check fine details on a small 
document. 

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 7.

2 From the Paper tab, select Fit to Page in the Printing 
Type drop-down list. 

3 Select the correct size from the Output size drop-down 
list.

4 Select the paper source, size, and type in Paper Options.

5 Click OK and print the document.

A
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Using Watermarks
The Watermark option allows you to print text over an existing 
document. For example, you may want to have large gray 
letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally 
across the first page or all pages of a document. 

There are several predefined watermarks that come with the 
printer, and they can be modified, or you can add new ones to 
the list. 

Using an Existing Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 7. 

2 Click the Extras tab, and select the desired watermark 
from the Watermark drop-down list. You will see the 
selected watermark in the preview image. 

3 Click OK and start printing. 

NOTE: The preview image shows how the page will look when 
it is printed.

Creating a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 7. 

2 Click the Extras tab, and click the Edit button in the 
Watermark section. The Edit Watermark window 
appears. 

3 Enter a text message in the Watermark Message box. 
You can enter up to 40 characters. The message displays 
in the preview window.

When the First Page Only box is checked, the watermark 
prints on the first page only.

4 Select watermark options. 

You can select the font name, style, size, or grayscale level 
from the Font Attributes section and set the angle of the 
watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list.   

6 When you have finished editing, click OK and start 
printing. 

To stop printing the watermark, select (No Watermark) from 
the Watermark drop-down list. 

Editing a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 7. 

2 Click the Extras tab and click the Edit button in the 
Watermark section. The Edit Watermark window 
appears.

3 Select the watermark you want to edit from the Current 
Watermarks list and change the watermark message and 
options. 

4 Click Update to save the changes.

5 Click OK until you exit the Print window. 

Deleting a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 7.

2 From the Extras tab, click the Edit button in the 
Watermark section. The Edit Watermark window 
appears. 

3 Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4 Click OK until you exit the Print window.
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Using Overlays

What is an Overlay?
An overlay is text and/or images stored in the computer hard 
disk drive (HDD) as a special file format that can be printed on 
any document. Overlays are often used to take the place of 
preprinted forms and letterhead paper. Rather than using 
preprinted letterhead, you can create an overlay containing the 
exact same information that is currently on your letterhead. To 
print a letter with your company’s letterhead, you do not need 
to load preprinted letterhead paper in the printer. You need only 
tell the printer to print the letterhead overlay on your 
document.

Creating a New Page Overlay
To use a page overlay, you must create a new page overlay 
containing your logo or image.

1 Create or open a document containing text or an image for 
use in a new page overlay. Position the items exactly as 
you wish them to appear when printed as an overlay.

2 To save the document as an overlay, access printer 
properties. See “Printing a Document” on page 7.

3 Click the Extras tab, and click Edit button in the Overlay 
section. 

4 In the Edit Overlay window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to eight 
characters in the File name box. Select the destination 
path, if necessary. (The default is C:\Formover).

6 Click Save. The name appears on the Overlay List box. 

7 Click OK or Yes to finish creating. 

The file is not printed. Instead it is stored on your 
computer hard disk drive. 

NOTE: The overlay document size must be the same as the 
documents you print with the overlay. Do not create an overlay 
with a watermark. 

WORLD BEST

Dear ABC

Regards

WORLD BEST

Using a Page Overlay
After an overlay has been created, it is ready to be printed with 
your document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 7. 

3 Click the Extras tab. 

4 Select the desired overlay from the Overlay drop-down 
list box. 

5 If the overlay file you want does not appear in the 
Overlay list, click Edit button and Load Overlay, and 
select the overlay file. 

If you have stored the overlay file you want to use in an 
external source, you can also load the file when you access 
the Load Overlay window. 

After you select the file, click Open. The file appears in the 
Overlay List box and is available for printing. Select the 
overlay from the Overlay List box. 

6 If necessary, click Confirm Page Overlay When 
Printing. If this box is checked, a message window 
appears each time you submit a document for printing, 
asking you to confirm your wish to print an overlay on your 
document. 

If this box is not checked and an overlay has been 
selected, the overlay automatically prints with your 
document. 

7 Click OK or Yes until printing begins. 

The selected overlay downloads with your print job and 
prints on your document. 

NOTE: The resolution of the overlay document must be the 
same as that of the document you will print with the overlay. 

Deleting a Page Overlay
You can delete page overlays that you no longer use. 

1 In the printer properties window, click the Extras tab. 

2 Click the Edit button in the Overlay section. 

3 Select the overlay you want to delete from the Overlay 
List box. 

4 Click Delete Overlay. 

5 When a confirming message window appears, click Yes.

6 Click OK until you exit the Print window.
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4 Sharing the Printer 
Locally
You can connect the printer directly to a selected computer, 
which is called “host computer,” on the network. 

The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.

NOTES: 
• Check the Operating System(s) that are compatible with 

your printer. Please refer to the OS Compatibility section of 
Printer Specifications in your Printer User’s Guide.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

Setting Up a Host Computer

1 Start Windows. 

2 From the Start menu select Printers and Faxes. 

3 Double-click your printer driver icon. 

4 From the Printer menu, select Sharing. 

5 Check the Share this printer box.

6 Fill in the Shared Name field, and then click OK.

Setting Up a Client Computer 

1 Right-click the Windows Start button and select Explore.

2 Select My Network Places  and then right-click Search 
for Computers.

3 Fill in the IP address of host computer in Computer name 
field, and click Search. (In case host computer requires 
User name and Password, fill in User ID and password 
of host computer account.)

4 Double-click Printers and Faxes.

5 Right-click printer driver icon, select Connect.

6 Click Yes, if the installation confirm message appears.
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5 Using Smart Panel
Smart Panel is a program that monitors and informs you of the 
status of the printer, and allows you to customize the printer’s 
settings. If you are a Windows or Macintosh OS user, Smart 
Panel is installed automatically when you install the printer 
software. If you are a Linux OS user, download Smart Panel 
from the Samsung website (www.samsung.com/printer) and 
install.

NOTES:
• To use this program, you need:

- To check for Operating System(s) that are compatible with 
your printer, refer to Printer Specifications in your Printer 
User’s Guide.

- Mac OS X 10.3 or higher
- Linux. To check for Linux systems that are compatible with 

your printer, refer to Printer Specifications in your Printer 
User’s Guide.

- Internet Explorer version 5.0 or higher for flash animation 
in HTML Help.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

Understanding Smart Panel
If an error occurs while printing, Smart Panel appears 
automatically, showing the error.

You can also launch Smart Panel manually. Double-click the 
Smart Panel icon on the Windows task bar (in Windows), or 
Notification Area (in Linux). You can also click it on the status 
bar (in Mac OS X).

Double-click this icon in Windows.

Click this icon in Mac OS X.

If you are a Windows user, from the Start menu, select 
Programs or All Programs  → your printer driver name → 
Smart Panel.

NOTES: 
• If you have already installed more than one Samsung 

printer, first select the printer model you want in order to 
use the corresponding Smart Panel. Right-click (in Windows 
or Linux) or click (in Mac OS X) the Smart Panel icon and 
select your printer name.

• The Smart Panel window and its contents shown in this 
Software User’s Guide may differ depending on the printer or 
Operating System in use.

The Smart Panel program displays the current status of the 
printer, the level of toner remaining in the toner cartridge(s) 
and various other information. You can also change settings.

Toner Level
You can view the level of toner remaining in the toner 
cartridge(s). The printer and the number of toner cartridge(s) 
shown in the above window may differ depending on the printer in 
use. Any printers do not have this feature.

Buy Now
You can order replacement toner cartridge(s) online.

Troubleshooting Guide
You can view Help to solve problems.

Driver Setting (Only for Windows)
You can use the printer properties window, which allows you to 
access all of the printer options you need for using your 
printer. For details, See “Printer Settings” on page 8.

Click this icon in Linux.

1

1

http://www.samsung.com/printer
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Opening the Troubleshooting 
Guide
Using the troubleshooting guide, you can view solutions for 
error status problems.

Right-click (in Windows or Linux) or click (in Mac OS X) the 
Smart Panel icon and select Troubleshooting Guide.

Changing the Smart Panel 
Program Settings
Right-click (in Windows or Linux) or click (in Mac OS X) the 
Smart Panel icon and select Options. 

Select the settings you want from the Options window.
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6 Using Your Printer in 
Linux 
You can use your machine in a Linux environment. 

This chapter includes:

• Getting Started

• Installing the Unified Linux Driver

• Using the Unified Driver Configurator

• Configuring Printer Properties

• Printing a Document

Getting Started
You need to download Linux software package from the 
Samsung website (www.samsung.com/printer) to install the 
printer softwares. 

After the driver is installed on your Linux system, the driver 
package allows you to monitor a number of machine devices via 
fast ECP parallel ports and USB simultaneously. 

The Unified Linux Driver package is supplied with a smart and 
flexible installation program. You don't need to search for 
additional components that might be necessary for the Unified 
Linux Driver software: all required packages will be carried onto 
your system and installed automatically; this is possible on a 
wide set of the most popular Linux clones.

Installing the Unified Linux 
Driver

Installing the Unified Linux Driver
1 Make sure that you connect your machine to your 

computer. Turn both the computer and the machine on.
2 When the Administrator Login window appears, type in 

root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to install the 
printer software. If you are not a super user, ask your system 
administrator.

3 From the Samsung website, download and unpack the 
Unified Linux Driver package to your computer.

4 Click the  icon at the bottom of the desktop. When the 
Terminal screen appears, type in: 

[root@localhost root]#tar zxf [FilePath]/
UnifiedLinuxDriver.tar.gz[root@localhost root]#cd 
[FilePath]/cdroot/Linux[root@localhost Linux]#./
install.sh

NOTE:  If you do not use the graphical interface and failed to 
install the software, you have to use the driver in the text 
mode. Follow the steps 3 to 4, and then follow the instructions 
on the terminal screen.

5 When the welcome screen appears, click Next.

http://www.samsung.com/printer
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6 When the installation is complete, click Finish.

The installation program has added the Unified Driver 
Configurator desktop icon and the Unified Driver group to 
the system menu for your convenience. If you have any 
difficulties, consult the onscreen help that is available 
through your system menu or can otherwise be called 
from the driver package Windows applications, such as 
Unified Driver Configurator.

NOTE: Installing the driver in the text mode:
• If you do not use the graphical interface or have failed the 

driver installation, you have to use the driver in the text 
mode.

• Follow the step 1 to 3, then type [root@localhost Linux]# ./
install.sh, than follow the instruction on the terminal screen. 
Then the installation completes.

• When you wan to uninstall the driver, follow the installation 
instruction above, but type [root@localhost Linux]# ./
uninstall.sh on the terminal screen.

Uninstalling the Unified Linux Driver
1 When the Administrator Login window appears, type in 

root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to install the 
printer software. If you are not a super user, ask your system 
administrator.

2 Click the  icon at the bottom of the desktop. When the 
Terminal screen appears, type in: 

[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

3 Click Uninstall.

4 Click Next. 

5 Click Finish.
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Using the Unified Driver 
Configurator
Unified Linux Driver Configurator is a tool primarily intended for 
configuring Printer.

After installing the Unified Linux driver, the Unified Linux Driver 
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver 
Configurator
1 Double-click Unified Driver Configurator on the 

desktop.

You can also click the Startup Menu icon and select 
Samsung Unified Driver and then Unified Driver 
Configurator.

2 Press each button on the Modules pane to switch to the 
corresponding configuration window.   

You can use the onscreen help by clicking Help.
3 After changing the configurations, click Exit to close the 

Unified Driver Configurator.

Printers Configuration button

Ports Configuration button

Printers Configuration
Printers configuration has the two tabs: Printers and Classes. 

Printers Tab
You can see the current system’s printer configuration by 
clicking on the printer icon button on the left side of the Unified 
Driver Configurator window.

You can use the following printer control buttons:

• Refresh: renews the available printers list.

• Add Printer: allows you to add a new printer.

• Remove Printer: removes the selected printer.

• Set as Default: sets the current printer as a default 
printer.

• Stop/Start: stops/starts the printer.

• Test: allows you to print a test page to check if the 
machine is working properly.

• Properties: allows you to view and change the printer 
properties. For details, see page 24.

Shows all of the 
installed printer.

Switches to Printer 
configuration.

Shows the status, 
model name and 
URI of your printer.
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Classes Tab
The Classes tab shows a list of available printer classes.

• Refresh : Renews the classes list.

• Add Class... : Allows you to add a new printer class.

• Remove Class : Removes the selected printer class.

Ports Configuration
In this window, you can view the list of available ports, check 
the status of each port and release a port that is stalled in busy 
state when its owner is terminated for any reason.

• Refresh : Renews the available ports list.

• Release port : Releases the selected port.

Shows the status of the 
class and the number of 
printers in the class.

Shows all of the 
printer classes.

Switches to 
ports 
configuration.

Shows the port type, 
device connected to 
the port and status

Shows all of the 
available ports.

Configuring Printer Properties
Using the properties window provided by the Printers 
configuration, you can change the various properties for your 
machine as a printer.
1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2 Select your machine on the available printers list and click 

Properties.
3 The Printer Properties window opens.

The following five tabs display at the top of the window:
•General: allows you to change the printer location and 
name. The name entered in this tab displays on the 
printer list in Printers configuration.

•Connection: allows you to view or select another port. If 
you change the printer port from USB to parallel or vice 
versa while in use, you must re-configure the printer port 
in this tab.

•Driver: allows you to view or select another printer 
driver. By clicking Options, you can set the default 
device options.

•Jobs: shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed 
jobs check box to see previous jobs on the job list.

•Classes: shows the class that your printer is in. Click 
Add to Class to add your printer to a specific class or 
click Remove from Class to remove the printer from the 
selected class.

4 Click OK to apply the changes and close the Printer 
Properties Window.
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Printing a Document

Printing from Applications
There are a lot of Linux applications that you are allowed to 
print from using Common UNIX Printing System (CUPS). You 
can print on your machine from any such application.
1 From the application you are using, select Print from the 

File menu.
2 Select Print directly using lpr.

3 In the LPR GUI window, select the model name of your 
machine from the Printer list and click Properties.

4 Change the printer and print job properties.

Click.

The following four tabs display at the top of the window.
•General - allows you to change the paper size, the paper 
type, and the orientation of the documents, enables the 
duplex feature, adds start and end banners, and changes 
the number of pages per sheet.

•Text - allows you to specify the page margins and set the 
text options, such as spacing or columns.

•Graphics - allows you to set image options that are used 
when printing images/files, such as color options, image 
size, or image position.

•Device: allows you to set the print resolution, paper 
source, and destination.

5 Click Apply to apply the changes and close the Properties 
window. 

6 Click OK in the LPR GUI window to start printing.

7 The Printing window appears, allowing you to monitor the 
status of your print job.

To abort the current job, click Cancel.

Printing Files
You can print many different types of files on the Samsung 
machine device using the standard CUPS way - directly from 
the command line interface. The CUPS lpr utility allows you do 
that. But the drivers package replaces the standard lpr tool by 
a much more user-friendly LPR GUI program.

To print any document file:
1 Type lpr <file_name> from the Linux shell command 

line and press Enter. The LPR GUI window appears.

When you type only lpr and press Enter, the Select 
file(s) to print window appears first. Just select any files 
you want to print and click Open. 

2 In the LPR GUI window, select your printer from the list, 
and change the printer and print job properties.

For details about the properties window, see page 25.
3 Click OK to start printing.
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7 Using Your Printer with 
a Macintosh
Your printer supports Macintosh systems with a built-in USB 
interface or 10/100 Base-TX network interface card. When you 
print a file from a Macintosh computer, you can use the CUPS driver 
by installing the PPD file. 

NOTE: Some printers do not support a network 
interface. Make sure that your printer supports a 
network interface by referring to Printer Specifications 
in your Printer User’s Guide.

This chapter includes:

• Installing Software

• Setting Up the Printer

• Printing

Installing Software
The CD-ROM that came with your printer provides you with the 
PPD file that allows you to use the CUPS driver or Apple 
LaserWriter driver (only available when you use a printer 
which supports the PostScript driver), for printing on a 
Macintosh computer. 

Printer driver

Installing the Printer driver
1 Make sure that you connect your printer to the computer. 

Turn on your computer and printer.

2 Insert the CD-ROM which came with your printer into the 
CD-ROM drive.

3 Double-click CD-ROM icon that appears on your 
Macintosh desktop.

4 Double-click the MAC_Installer folder.

5 Double-click the Installer icon.

6 Enter the password and click OK.

7 The Samsung Installer window opens. Click Continue.

8 Select Easy Install and click Install. Easy Install is 
recommended for most users. All components necessary 
for printer operations will be installed. 
If you select Custom Install, you can choose individual 
components to install.

9 The message which warns all application will close on your 
computer appears, Click Continue.

10After the installation is finished, click Quit.

NOTE:After installation, you need to set up the connection 
between the printer and your computer. See “Setting Up the 
Printer” on page 27.

Uninstalling the Printer driver
Uninstall is required if you are upgrading the software, or if 
installation fails.
1 Make sure that you connect your printer to the computer. 

Turn on your computer and printer.

2 Insert the CD-ROM which came with your printer into the 
CD-ROM drive.

3 Double-click CD-ROM icon that appears on your 
Macintosh desktop.

4 Double-click the MAC_Installer folder.

5 Double-click the Installer icon.

6 Enter the password and click OK.

7 The Samsung Installer window opens. Click Continue

8 Select Uninstall and then click Uninstall.

9 The message which warns all application will close on your 
computer appears, Click Continue.

10When the uninstallation is done, click Quit.
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Setting Up the Printer 
Follow the instructions on “Installing Software” on page 26 to 
install the PPD and Filter files on your computer.
1 Open the Applications folder → Utilities, and Print 

Setup Utility.

•For MAC OS 10.5~10.6, open System Preferences from 
the Applications folder, and click Print & Fax.

2 Click Add on the Printer List.

•For MAC OS 10.5~10.6, press the “+” icon then a display 
window will pop up. 

3 For MAC OS 10.3, select the USB tab. 

•For MAC OS 10.4, click Default Browser and find the 
USB connection.

•For MAC OS 10.5~10.6, click Default and find the USB 
connection.

4 For MAC OS 10.3, if Auto Select does not work properly, 
select Samsung in Printer Model and your printer 
name in Model Name. 

•For MAC OS 10.4, if Auto Select does not work properly, 
select Samsung in Print Using and your printer name 
in Model. 

•For MAC OS 10.5~10.6, if Auto Select does not work 
properly, select Select a driver to use... and your 
printer name in Print Using. 

Your machine appears on the Printer List and is set as the 
default printer.

5 Click Add.



Using Your Printer with a Macintosh
28

Printing 

NOTES: 
• The Macintosh printer’s properties window that appears in 

this User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• You can check your printer name in the supplied CD-
ROM.

Printing a Document
When you print with a Macintosh, you need to check the printer 
software setting in each application you use. Follow these steps 
to print from a Macintosh.

1 Open a Macintosh application and select the file you want 
to print.

2 Open the File menu and click Page Setup (Document 
Setup in some applications). 

3 Choose your paper size, orientation, scaling, and other 
options and click OK.

4 Open the File menu and click Print.

5 Choose the number of copies you want and indicate which 
pages you want to print. 

6 Click Print when you finish setting the options.

▲ Mac OS 10.3

Make sure that your 
printer is selected.

Changing Printer Settings
You can use advanced printing features when using your 
printer.

From your Macintosh application, select Print from the File 
menu. The printer name which appears in the printer properties 
window may differ depending on the printer in use. Except for 
the name, the composition of the printer properties window is 
similar.

NOTES: The setting options may differ depending on printers 
and Macintosh OS version.

Layout
The Layout tab provides options to adjust how the document 
appears on the printed page. You can print multiple pages on 
one sheet of paper. Select Layout from the Presets drop-down 
list to access the following features.

•Pages per Sheet: This feature determines how many 
pages printed on one page. For details, see "Printing 
Multiple Pages on One Sheet of Paper" on the next 
column.

•Layout Direction: You can select the printing direction 
on a page as like the examples on UI.

▲ Mac OS 10.4
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Graphics

The Graphics tab provides options for selecting 
Resolution(Quality) and Color Mode. Select Graphics 
form the Presets' drop-down list to access the graphic 
features.

•Resolution(Quality): You can select the printing 
resolution. The higher the setting, the sharper the clarity 
of printed characters and graphics. The higher setting 
also may increase the time it takes to print a document.

Paper

Set Paper Type to correspond to the paper loaded in the tray 
from which you want to print. This will let you get the best 
quality printout. If you load a different type of print material, 
select the corresponding paper type.

▲ Mac OS 10.4

▲ Mac OS 10.4

Printing Multiple Pages on One Sheet 
of Paper
You can print more than one page on a single sheet of paper. 
This feature provides a cost-effective way to print draft pages.

1 From your Macintosh application, select Print from the 
File menu. 

2 Select Layout.

3 Select the number of pages you want to print on one sheet 
of paper on the Pages per Sheet drop-down list.

4 Select the page order from the Layout Direction option.

To print a border around each page on the sheet, select 
the option you want from the Border drop-down list.

5 Click Print, and the printer prints the selected number of 

pages on one side of each page.

▲ Mac OS 10.3
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SOFTWARE SECTION 
INDEX

A
advanced printing, use 13

B
booklet printing 14

D
document, print

Macintosh 28
Windows 7

double-sided printing 15

E
Extras properties, set 11

F
favorites settings, use 12

G
Graphics properties, set 10

H
help, use 12

I
install

printer driver
Macintosh 26
Windows 4

Installing 21
installing

Linux software 21

L
Layout properties, set

Windows 9
Linux

driver, install 21
printer properties 24
printing 25

M
Macintosh

driver
install 26
uninstall 26

printing 28
setting up the printer 27

N
n-up printing

Macintosh 29
Windows 13

O
orientation, print 25

Windows 9
overlay

create 17
delete 17
print 17

P
Paper properties, set 9
paper size, set 9

print 25
paper source, set 25

Windows 10
paper type, set

print 25
poster, print 14
print

document 7
fit to page 15
from Macintosh 28

from Windows 7
N-up

Macintosh 29
Windows 13

overlay 17
poster 16
PRN 8
scaling 15
watermark 16

print resolution 25
printer driver, install

Linux 21
printer properties

Linux 25
printer properties, set

Macintosh 28
Windows 8

printer resolution, set
Windows 10

printer software
install

Macintosh 26
Windows 4

uninstall
Macintosh 26
Windows 6

printing
booklets 14
double-sided 15
from Linux 25

R
resolution

printing 25

S
setting

darkness 10
favorites 12
image mode 10
resolution

Windows 10
toner save 10
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true-type option 10
software

install
Macintosh 26
Windows 4

reinstall
Windows 6

system requirements
Macintosh 26

uninstall
Macintosh 26
Windows 6

status monitor, use 19

T
toner save, set 10

U
uninstall, software

Macintosh 26
Windows 6

Uninstalling 22

W
watermark

create 16
delete 16
edit 16
print 16
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